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Welcome

Thank you for taking this course which covers the basics of computers and computer use, 
both Macintosh and Windows. If you are reading this online, you may wish to use the physical 
copy of  the workbook which was sent to you when I received notification of your enrollment. 

Over the years (decades really) I have found having a physical workbook alongside your 
computer is the most efficient way of gathering and processing information. Having to bounce 
back and forth between screen and windows on a computer can be disconcerting at best. 

Using Canvas to access the projects can be kept at a minimum if you prefer. About half of 
the required projects are turned in using Google Forms, accessed through either Canavas 
or the course website. The hands-on projects are saved to your computer (or the cloud) then 
uploaded to Canvas at the end of the course.

Please take time and review the entire workbook before 'jumping ahead' to the projects. 
Countless questions and periods of frustration can be avoided if you familiarize yourself with 
the introduction and lead-in instructions to each project. 

As with my other courses, this one is built on a 'step-by-step' approach to learning. The pro-
cess may seem long winded when you are doing it, but you will be able to transfer your new 
skills and experience to a wide array of situations, whether you are creating for yourself or 
passing on your knowledge to your students, 

My hope is that you succeed and enjoy while learning. I appreciate, respect and rely on your 
candor in amy feedback you provide when completing the course evaluation. Your honesty 
would never effect your grade. On an ongoing basis I review and revise all my courses! His-
torically the changes made have been effected based on your recommendations. I really do 
listen!
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TEC 923 Companion Website
An integral and essential component of your course materials is the TEC 923 companion 
website (URL below). Among other things, included on the website you will find links to 
Google Forms - the mechanism whereby you will be submitting several assignments. There 
are links to course readings / videos / help files and some of the relevant topics the course 
covers. There is also a .pdf copy of this workbook in the event you wish to work on the course 
while away on vacation and forget to pack the workbook!

www.intro.steveyoungfpu.net 
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Downloading Companion Files
One link on the course website is titled 'Download Course Files' which contains files and 
folders necessary to complete many of the course assignments. Clicking on the link will 
download a .zip file to your computer. The assumption is your computer is set up to accept 
downloads (some school districts may block this function). Download this file before you 
begin the course. If there is an issue with this, please let me know.

On a Macintosh, the download will appear in the default location, usually the Downloads folder. 
Double-clicking the .zip icon will create 
the course resources folder.

On a Windows computer, a small window will appear 
when the link is clicked. Choose the 'Save' button 
and click.

A new set of buttons will appear. Click the 'Open 
Folder' button.

In the folder, a .zip file icon will appear. Double-click-
ing the icon will create the course resource folder. 
I would strongly suggest dragging the new folder 
onto the desktop for easy access - otherwise you 
will need to locate and unzip the file every time 
you want to access it.

Inside the TEC 923 folder are several folders. Dou-
ble-clicking a folder will reveal its contents.

ZIP file icon Folder icon
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Submitting Coursework

There are two methods of submitting coursework for TEC 923: Google Forms and  .
The question / answer forms are done through Google Forms. The 'hands on' projects, where 
you create original documents using a word processor, spreadsheet and a computer graphics 

program, are saved to your computer's hard drive (or the cloud) then 
uploaded to Canvas at the end of the course. It is strongly suggested 
you keep all your self-created, hands-on projects in one master folder/
portfolio.

Steps to upload your portfolio to Canvas

Login to your Canvas account and access 
the TEC 923 Introduction to Computers 
course.  

Scroll to the bottom of Module 5 and click 
the "Portfolio Submission" link. This brings 
up an instruction page. 

If you have not done so, gather all your 
projects (except the Google Forms) in a 
folder.

Drag the folder onto the image well. You 
will see an upload indicator as your folder 
transferrs to Canvas. 
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Course Completion Checklist  

	 Project 1: 	 Pre-course Teacher Survey #1

	 Project 2:	 Reading Reflection  

	 Project 3:	 Parts of a Computer

	 Project 4:	 Inside Your Computer

	 Project 5:	 Treasure Hunt

	 Project 6:	 Word Processing - Typing Skills

	 Project 7:	 Word Processing - Working With Text

	 Project 8:	 Word Processing - Fonts

	 Project 9:	 Word Processing - Margins

	 	 Project 10:	 Word Processing - Tabs

	 Project 11:	 Word Processing - Letter To Parents

	 Project 12:	 Simple Spreadsheet - The Basics

	 Project 13:	 Simple Spreadsheet - Spreadsheet With Pie Chart

	 Project 14:	 Graphics - Doodling in Paint

	 Project 15:	 Graphics - Geometric Shapes

	 Project 16:	 Graphics - Using Tools in Paint

	 Project 17:	 Graphics - Import & Edit An Image

	 Project 18:	 Internet Survey

	 Project 19:	 Internet Site

	 Project 20: 	 E-mail

	 Project 21: 	 Standards Correlation Chart & Discussion

	 Project 22: 	 Post-course Teacher Survey #2

	 Project 23: 	 Course Evaluation

		  Submit Request for Online Grading	

										          					   

					              Rev 07/01/2022
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Why Learn About Computers?
Evidence from various studies conducted over the past decade confirm that educational technologies 
can improve student achievement, so long as such tools are integrated thoughtfully into teaching and 
learning. When digital capabilities (such as engaging online environments, access to a wide array 
of  resources, and interactivity) are incorporated meaningfully into instruction, students have new 
opportunities to learn and achieve. Below are some highlights of the meta-study.

• Reading: A recent meta-analysis of 84 rigorous studies compares the impact of various technolo-
gies (computer-managed learning, innovative technology applications, supplemental technology, and 
comprehensive models) on K12 reading achievement. Comprehensive models that integrate computer 
assisted instruction with other activities as a core reading program appear to produce the largest im-
provements in reading scores.

• Mathematics:  A meta-analysis of 74 rigorous studies on K12 mathematics computer applications 
indicates that such programs produce small but positive  effects on mathematics achievement. Specifi-
cally, programs that supplement traditional math instruction with additional computer assisted instruction 
at students’ individualized assessed levels of need have the greatest effects on math achievement.

• Writing: A systematic review of studies in peer-reviewed journals between 2005 and 2010 finds that 
participation in one-to-one computer projects (wherein each student is provided a digital device) to 
improved student motivation and engagement in learning, slightly improved students’ writing skills, 
proficiency with the use of digital tools, and scores on high-stakes tests. Another study  indicates that 
students using laptops regularly outperform their peers in four areas of writing: content, organization, 
language/voice/style, and mechanics.

Keys to the Successful Implementation of Technology for Student Learning 

1. Provide effective professional development for teachers on the instructional integration of  technology 

2. Embed the use of technology within the daily school schedule 

3. Directly support the curriculum objectives being assessed through technology 

4. Adjust for students’ abilities and prior experiences, and provide feedback to the student and teacher 
about student performance or progress with the application 

5. Provide opportunities for student collaboration 

6. Provide opportunities for students to design and implement projects that extend the curricular content  
being assessed by a particular standardized test 

7. Foster school environments where teachers, the school community, and school and district admin-
istrators support the use of technology 

Source: International Society for Technology in Education (ISTE), 2013 
Found at: https://www.arccta.org/sites/default/files/general_uploads/Research%20Brief%20Does%20Ed%20Tech%20Improve%20Stu-
dent%20Learning.pdf
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Project 1:	 Pre-Course Teacher Survey #1 
To fill out and submit this form, please go to the Pre-Course Survey link on the course website. I have copied 
the survey here merely for reference; you will submit your responses via the Course Website.  A copy of your 
completed form should be e-mailed to you after submitted.  A couple brief, succinct sentences should suffice.

What grade level and/or subject(s) do you currently 
teach?

What technology is currently available to you at 
home? 

What technology is available to you at your school? 
Are you using technology to prep and/or deliver in-
struction? If so, what/how?

Describe your level of understanding and experience 
using computers for school-related work. 

Describe your comfort level when required to imple-
ment new technology in your classroom (electronic 
grade books, attendance, etc.). Do you view technol-
ogy as beneficial and a time-saver, or intimidating 
and unnecessarily complicated?

What do you hope to get out of this course?
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1.	 Which article did you chose? 

2.	 What are your general feelings concerning the article?

3.	 Cite a specific example or concept within the article you found particularly useful then 
explain your rationale.

4.	 Did any concept or real-world example from the article change your opinion or attitude 
toward using computers in the classroom?

Project 2:	 Reading Reflection
Go to the course website, www.intro.steveyoungfpu.net  - left hand column, titled The Basics.

There you will find three readings; one in PDF format and two online articles. The PDF article 
is one I have been offering to students for years, as it is very well written. The downside is it is 
rather old, but I believe the basic thrust of the content still holds true today in many respects. 

I have provided two alternative (online) readings; take a look at all three, chose one, then 
respond to the following questions below. Your responses should be word-processed then 
saved to your computer (or in the cloud). If you prefer, the course resources folder which you 
downloaded contains a PDF form on which you can type your answers.

Later in the course you will upload it, along with other assignments, to your Canavas course 
page.
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*IMPORTANT* - PLEASE NOTE: Throughout the workbook you 
will see the icons to the left. The parallel text for each platform is 
indicated by the Apple for Macintosh and the Microsoft flag for Win-
dows. If you are using one type of computer exclusively you may 
concentrate on just that system or learn about both. The choice is 
yours.

Macintosh

Windows

Let's Get Started Learning About Your Computer!
In this section you will gain an understanding of: 

•	 General computer terminology

•	 Basic components of a personal computer system

This section, like the others to follow, will illustrate and demonstrate on both the Macintosh 
and Windows platforms. 

Illustrations in this section of the workbook are from a mixture of computers: Windows XP, 
Windows 7, Windows 8.1, Windows 10 and Macintosh OSX 10.6 through 10.11.
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The Outside Parts
In order to understand how computers work, you must first acquaint yourself with the different 
parts, or devices. A computer consists of both hardware and software working together to 
help you accomplish tasks. Input devices, output devices, the processor or central processing 
unit (CPU), and memory make up what is known as the computer's hardware (the physical 
components of the computer system). 

LCD Screen

Keyboard

Trackpad
(mouse substitute)

Desktop Computer

Laptop Computer

CPU, Solid State Drive
and Battery

Monitor

Speakers

CPU, Hard Drive, CD-ROM

Keyboard Mouse

Speakers
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Central Processing Unit 
All desktop computers have a CPU (Central Processing Unit) enclosure. This box houses the 
main circuitry and components of a computer. Memory, storage, a cooling fan and places to 
plug in the power cord, keyboard, mouse, printer, monitor and other accessories are contained 
inside the CPU box. There are several styles of enclosures, based on function and style. Some 
CPUs also have a DVD / CD-ROM drive built in but they are becoming obsolete.

The tower style computer typically sits under, on top, or 
next to a desk. The monitor and keyboard are separate.

All-in-One desktop computers contain the CPU, 
monitor and speakers all in one unit.

Laptop computers are also all-in-one computers 
with the addition of a built-in keyboard.
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Monitors
The main output of a computer is visual and is displayed on the monitor. Early computers 
used a standard television set as the monitor, but the resolution of the screen limited it to 
large printing and simple graphics. Modern computer screens are crystal clear and have very 
stable pictures. 

Liquid crystal displays (LCD) have always 
been used in laptop computers and have 
now replaced the older CRT monitors. LCDs 
are light, thin and take up virtually no desk 
space. There  are several different tech-
nologies used in manufacturing flat screen 
displays, and offer varying degrees of pic-
ture quality. Typically they may range in size 
(measured diagonally) from 14” to over 30”.

Computers can display images on a monitor at different resolutions. This means that on 
any given size monitor, it is possible to display an image in different sizes. Below, the same 
screen is displayed at 920 X 1200 pixels (left) and 2560 x 1600 pixels (right). Note that more 
information is displayed on the right, but the images are smaller.

Newer computers are capable of run-
ning two or more monitors at once.
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Storage Devices
Every computer must have a way of storing information, such as programs and documents.  
Hard drives, the most common storage device, use spinning magnetic platters which store 
data. Hard drives must be formatted at the factory. Formatting is like putting a road map on 
the hard drive; a way for the computer to know where to put the information on the hard drive, 
since it will be placed (written) and retrieved (read) from the hard drive randomly. 

Hard drive sizes are measured in gigabytes (GB). The larger the number, the greater the 
storage capacity of the drive. Most computer hard drives already have some data stored on 
them: the computer’s operating system. Other programs may be present, or will need to be 
loaded (written) on the hard drive from a disk or downloaded from the internet. 

Think of a hard disk drive (HDD) like a cross 
between a home VCR (recording magnetically) 
and an old-fashioned record player (with a 
stylus reading information across a spinning 
disk).

An optical drive can record and play 
data, music and movies. These are 
quickly becoming obsolete.

A Solid State Drive (SSD) performs the same 
function as a Hard Drive, but with no moving 
parts, and much faster data transfers.

Cloud Storage has become a robust stor-
age medium, whereby data is saved to and 
retrieved from an internet-based service.

USB drives (AKA thumb/ flash drives) 
are small external storage devices 
that store up to 1 TB of data (512 GBs 
is more common though).
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Input Devices

You use the keyboard to type information 
into your computer or access commands. 
There are many different styles of computer 
keyboards, but they all provide the same basic 
functionality.

By clicking the buttons on a mouse, you tell the 
computer to take a specific action. In most computer 
programs which utilize a mouse, the way you click 
the buttons sends different signals to the computer.

Flatbed Scanners, video cameras and digital document cameras input pictures and video 
into the computer for storage, editing, or placement on the web. Microphones (either built-in 
or external) input music and speech for multimedia projects, speech-to-text programs, or to 
control the computer.

There are many input devices you can use 
to get information into your computer. The 
two most common are the keyboard and the 
mouse, but remember - the most important 
input device on any computer is you!

For laptop computers, the trackpad performs the 
same function as a mouse.



Page 16 Introduction to Computers for Teachers

Output Devices

Sounds require computer speakers, either built-in or external.

A printed copy of your information can be sent to a 
printer. Printers are either inkjet or laser, color or 
black-and-white. Some printers are designed for 
individual use, and some for high-volume network 
(multi-user) use.

Most computers are able to output images (both 
still and moving) onto a television set or video 
projector for group viewing. 

The main output device on your computer 
is the monitor. Monitors are also called 
screens or displays. There are many differ-
ent types of monitors and the main differ-
ences between them are screen size and 
image quality.
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Input
The basic layout of the keys on the computer keyboard evolved from an earlier office workhorse, 
the typewriter, first patented in 1867 by Christopher Latham Sholes, a Wisconsin newspaper 
editor and printer. The typewriter was successfully mass-marketed six years later by the fire-
arms company Remington & Sons. That company went on to become Remington Rand which, 
in 1951, launched Univac - the first commercial mainframe computer in the United States. 

Despite this distant kinship, however, the differences between computer keyboards and 
typewriters far outweigh their apparent similarities. The first distinction is that the keys on a 
computer keyboard, unlike those of a typewriter, have no intrinsic meaning. 

The keys are marked with letters of the alphabet and numbers, but they can be assigned an 
infinite variety of other meanings depending on what is wanted by program designers, systems 
engineers, and even the individual user, who is also able to customize the keyboard. Thus, 
while depressing the letter "q" means "q" in a word processing context, it can just as easily 
mean "move the queen" in a chess program or "quit" in a math program. 

In some other application it can be assigned a meaning that has no connection at all to the 
letter "q" in the alphabet. In addition to conventional typewriter keys, the keyboard also has 
function keys which can be assigned a variety of tasks to meet the demands of different soft-
ware packages. There are also several single purpose keys on the keyboard. These include 
the cursor or arrow keys, which are used to move an on-screen marker called the cursor.  
The cursor’s feedback helps the user interact with the computer by indicating the location of 
the next character to be entered. 

While the keyboard is a fast, efficient tool for entering text,  the mouse is often far quicker and 
more convenient when it comes to moving the cursor around the screen. The mouse works as 
an analog for the cursor. Moving the mouse along a flat surface moves the cursor in the same 
relative direction on the screen. As the user propels the mouse along, this action changes the 
cursor’s horizontal and vertical screen coordinates. By checking these map references, the 
computer knows the position of the cursor. 

The software being used generates on-screen icons and menus tailored to each program. With 
the cursor positioned on the desired command or object,  the user clicks a button mounted on 
the mouse to send input into the computer. The mouse displays its advantage when it is used 
to point and click on icons and pull down menus. It really comes into its own in graphic ap-
plications, when it is used as a paintbrush or a stylus or to move graphics around the screen. 

Mice come in two varieties, mechanical and optical. The more common mechanical mouse has 
several moving parts. The most conspicuous is a roller ball that is clearly visible underneath 
the device. The trackball is simply an upside down variant of the mouse. While a mouse must 
roam about a desktop or a pad to do its work, in a trackball,  only the roller ball moves; the 
unit, itself, remains stationary. 
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Input is the gateway from the outside world (you and all your knowledge) and the computer. 
Through input devices, you tell the computer what to do. There are two indispensable devices 
for this; the mouse and the keyboard. You use a mouse to translate your hand movements 
into movements of an on-screen pointer. By controlling the pointer with the mouse, you are 
able to input information and instructions by selecting, rather than typing. The following tasks 
can be done using a mouse:

The Mouse

Glossary

Mouse: A small, hand-controlled input device that relays signals to the computer which moves 
a corresponding pointer on the monitor screen.

Icon: A small graphic or pictorial representation of an idea or action. Icons are used to save 
screen space and give the user labels of commands and options within a program (i.e. an 
icon such as             tells the user to “click here and I will print out your document").

Point: The act of moving the mouse cursor to an area (usually a word or Icon). The tip of the 
arrow is the ‘hot spot”, and must be touching (on top of) the word or icon to properly 'point' to 
that object (ie the cursor is on the number 3.)

Click: Pressing down, then releasing the mouse button (the left side button on a Windows 
mouse). On a Macintosh, there is only one button (with a right and left side); however the 
same functionality of a two or three button mouse is achieved by holding down the control key.

Double - Click: Pressing down, then quickly releasing the mouse button (the left side button 
on a Windows mouse) twice in rapid succession.

Right - Click: On a Windows computer, clicking (pressing down, then releasing) the right side 
mouse button. On a Macintosh, control-click performs similar actions.

Drag: Pressing down and holding down the mouse button (the left-side button on a Windows 
mouse) and moving the mouse (and the cursor) to a new physical location. The action is 
click - move - unclick.

Optical Mouse: Some mice use an optical sensor instead of a rolling mouse ball to sense 
movement. These mice are more accurate (and forgiving) than older mice.

       • Move a cursor      • Select and change information      • Choose items from a menu 
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Turn the mouse back over and place on a flat, non-reflective surface (an optical mouse will not 
work on glass or shiny surfaces). The cable connecting the mouse to the computer should be 
pointed away from you. With your hand cupped over the top of the mouse, move the mouse 
over a flat surface. As you begin to move the mouse, look at the monitor. You will notice a 
small arrow (see  picture below) moving around the screen as you move the mouse.

 The Mouse Pointer or Cursor

NOTE: When selecting (clicking, holding and dragging), if you run out of flat surface before 
running out of computer screen, with the mouse still depressed, pick it up and place it back 
on the flat surface closer to the center, then continue moving the mouse. The pointer will re-
main stationary on the screen until the mouse ball comes in contact with the flat surface and 
begins moving again. 

You should spend some time getting comfort-
able with the mouse you will be using. Pick the 
mouse up and look at the bottom. The optical 
mouse has a tiny LED (light emitting diode) 
or laser which emits red light. That light is 
bounced off a surface (like a mouse pad or the 
surface of your desk) which is in turn sensed 
by the mouse to determine the position of the 
cursor. Think of it like an Etch-a-Sketch. Older 
mice use a mechanical roller ball and spinning 
disks to perform the same task.

Apple Magic Mouse Windows Mouse 
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The Keyboard
The most common, and still the best way to get your thoughts into a computer, is through the 
keyboard. The keyboard is the same QWERTY keyboard typewriters use, invented in 1873. 

Most schools introduce keyboarding as the first step in their technology-based learning program, 
as it is essential that typing skills be mastered before one can move on to applications such 
as word processing. In addition to letter keys, keyboards have several modifier keys, functions 
keys and hardware/software specific keys. Here is a glossary of some of the most common:

Glossary         

Command Key: (Macintosh): Also called the Apple key, it is used to send menu commands 
to the computer.              The equivalent of the control key in Windows.

Control Key:  (Windows):  it is used to send menu commands to the computer             .
The equivalent of the command key in Macintosh.        

Option / ALT Key: (Windows and Mac): Allows access to special characters on the keyboard 
(i.e. pressing option and the letter v will produce a √).

F (Function) Keys: 1 through 12 (Windows and some Macintosh): On Windows computers 
F-Keys provide shortcuts to system and program menu items (see next page).

Escape Key:  (Windows and Mac): Typically tells the computer to “stop” or “go back” when 
running a program, especially one where several choices are presented.

Shift Key:  (Windows and Macintosh): Like a typewriter, allows for the typing of upper case 
letters and characters (such as those on the number keys).

Return Key:  (Windows and Macintosh): When typing text, enters a “hard return” forcing the 
cursor to the next line down. It can also be used to accept the default  button in a dialog box 
On some computers, it is labeled CR (Carriage Return).

Enter Key: With some programs, the Enter key performs the same function as the Return 
key; in other programs (such as spreadsheets), the enter key validates the input.

Delete/Backspace Key:  (Windows and Macintosh): This key un-types text, just like a type-
writer. With most programs, it can be made to un-type letters to the left or to the right of the 
text cursor.
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System / Application Shortcuts

Editing Shortcuts

There are many keyboard 
shortcuts which are virtually 
the same on both Macintosh 
and Windows computers. 
These are the most common, 
and you should learn them. 
They allow your hands to 
stay on the keyboard rather 
than always reaching for the 
mouse. Note that, for the most 
part, they are mnemonic, with 
the first letter of what they do 
(i.e. print) as their designation 
(i.e. control-p).

Whether it is writing a letter 
or designing a web page, you 
should always take advantage 
of the power a computer has to 
offer. One way of doing  this is to 
use editing commands to copy, 
paste and delete text or graphics. 
Almost all programs use these 
keyboard shortcuts.
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Macintosh Keyboard

FK
ey

s
Ar

e 
no

rm
al

ly
 in

ac
tiv

e 
un

le
ss

 p
ro

gr
am

m
ed

 
by

 t
he

 u
se

r. 
Ne

w
er

 M
ac

s 
us

e 
so

m
e 

of
 

th
es

e 
ke

ys
 t

o 
ad

ju
st

 s
pe

ak
er

 v
ol

um
e 

an
d 

sc
re

en
 b

rig
ht

ne
ss

.

ES
CA

PE
Le

ts
 y

ou
 c

an
ce

l a
n 

en
tr

y

TA
B

In
 a

 w
or

d 
pr

oc
es

so
r, 

pr
es

sin
g 

th
e 

ta
b 

ke
y 

m
ov

es
 t

he
 in

se
rt

io
n 

po
in

t 
to

 t
he

 
ne

xt
 t

ab
 p

os
iti

on
. 

Th
e 

ta
b 

ke
y 

al
so

 
m

ov
es

 t
he

 c
ur

so
r f

ro
m

 o
ne

 t
ex

t 
fie

ld
  

to
 t

he
 n

ex
t 

in
 m

os
t 

pr
og

ra
m

s.

BA
CK

SP
AC

E/
DE

LE
TE

Pr
es

si
ng

 t
hi

s 
ke

y 
de

le
te

s 
th

e 
la

st
 

le
tt

er
 y

ou
 t

yp
ed

 -
 o

r 
w

ha
te

ve
r 

te
xt

, 
pi

ct
ur

e 
or

 e
le

m
en

t 
is 

se
le

ct
ed

.

RE
TU

RN
Th

is 
ke

y 
in

se
rt

s 
a 

ha
rd

 re
tu

rn
 o

r p
ar

a-
gr

ap
h 

ch
ar

ac
te

r i
nt

o 
te

xt
. I

n 
a 

di
al

og
 

bo
x,

 it
 is

 e
qu

iv
al

en
t 

to
 t

he
 E

nt
er

 k
ey

,

SH
IF

T
Ch

an
ge

s 
lo

w
er

 
ca

se
 l

et
te

rs
 t

o 
up

pe
r c

as
e.

CA
PS

 L
OC

K
Lo

ck
s 

up
pe

r 
ca

se
 

le
tt

er
s 

(b
ut

 n
ot

 
sp

ec
ia

l c
ha

ra
ct

er
s 

on
 n

um
be

r k
ey

s)
.

OP
TI

ON
Th

is 
ke

y 
le

t 
yo

u 
ty

pe
 s

pe
-

ci
al

 c
ha

ra
ct

er
s 

(é
, 

ñ,
 ¿

, 
et

c.
). 

It 
is 

al
so

 u
se

d 
in

 so
m

e 
ke

yb
oa

rd
 s

ho
rt

cu
ts

.

CO
M

M
AN

D 
or

 A
PP

LE
Us

in
g 

th
is 

ke
y 

in
 a

dd
iti

on
 to

 d
efi

ne
d 

le
tt

er
 k

ey
s 

in
vo

ke
s 

a 
m

en
u 

co
m

-
m

an
d 

(c
al

le
d 

a 
ke

yb
oa

rd
 s

ho
rt

cu
t)

.

AR
RO

W
 K

EY
S

Th
es

e 
ke

ys
 l

et
 y

ou
 

m
ov

e 
th

e 
in

se
rt

io
n 

po
in

t 
in

 t
ex

t,
 m

ov
e 

fr
om

 c
el

l t
o 

ce
ll 

in
 a

 
sp

re
ad

sh
ee

t o
r r

ep
o-

sit
io

n 
im

ag
es

.

EN
TE

R
Th

is 
ke

y 
le

ts
 y

ou
 v

al
i-

da
te

 a
n 

en
tr

y 
in

 s
om

e 
pr

og
ra

m
s.

 In
 o

th
er

 p
ro

-
gr

am
s,

 it
 is

 a
 s

ec
on

d 
Re

tu
rn

 k
ey

.

CO
NT

RO
L

Th
is

 k
ey

 i
s 

us
ed

 in
 s

om
e 

k
e

y
b

o
a

rd
 

sh
or

tc
ut

s.



Page 23 Introduction to Computers for Teachers

Windows Keyboard

There a four main parts to the Windows keyboard; the standard typewriter section, cursor 
keys, numeric keypad and the function keys. Some keyboards include other keys for turning 
on and off the computer, keys for web use, multimedia keys, and some with volume controls 
and short cut keys for all sorts of functions.

The numeric keypad has two defined operations which is toggled 
with the number lock key. There is usually a green light which in-
dicates that the number lock is on or off. When the light is on, the 
keypad uses the upper symbols displayed on the keys.

The function keys can be programmed by each piece of software you run. The only key in 
this group that is used only for ONE task is the Help key which is used for displaying the help 
files. This is programmed by Windows as a default - anytime you have a question on what 
you are doing, the Help key is a good place to start.

Typewriter keys

Windows and task keysCursor Numeric keypad

Function keys
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Project 3:	 Parts of a Computer
To fill out and submit this form, please go to the Parts of a Computer Survey link on the course website (below is only a partial image of the 
assignment). A copy of your completed form should be e-mailed to you after you have submitted it. 
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Glossary of Computer Terms
Here are some common terms you should familiarize yourself with. They will help you better 
understand the workings of your computer and software and make communicating with others 
easier, given a common vocabulary.

Bit: Stands for "binary digit", which can have a value of 0 or 1; the smallest unit of information 
in digital computer systems. 

Boot Up: To load an operating system into the computer's random access memory.

Byte: A group of 8 adjacent bits. Usually the amount of space required to store the binary 
value for one printed character. Abbreviation: b. 

CD-ROM stands for "Compact Disc - 'Read Only' Memory". Read only means you can not 
write information back to them (change, alter or ad to).

Cloud Storage: the generic name for placing files onto remote internet - accessable servers. 
Popular cloud storage services include Dropbox, iCloud, Google Cloud and OneDrive.

CPU: "Central Processing Unit"; the main component in a computer where most calculations 
take place; the microprocessor. 

Display: Another name for a computer monitor.

Dot pitch: the distance between the pixels on the monitor. The smaller the distance, the 
clearer the picture resolution. 

DVD: stands for "Digital Versatile Disk" and is the successor of the CD-ROM and Video Tape. 
It is capable of holding video and/or computer data at a capacity of nearly 5 GB.

Format: To prepare a floppy disk or hard drive to hold data. An analogy would be to draw lines 
on a sheet of paper in preparation for writing.

Function Key: One of several special buttons on a computer keyboard which can be pro-
grammed to perform certain tasks, such as sending a document to a printer. Also called the 
F-Key

Gigabyte: A billion bytes. Abbreviation: GB.

GUI: Graphical User Interface. Means of communicating between computer and user by point-
ing via a mouse to move a pointer on the computer screen, select icons or menu items.

Hard Drive: Digital storage device containing one or more inflexible magnetic platters on 
which data can be recorded. Sealed in a case, it is not removable. 

Hardware: The physical components of a computer system or network.

Inkjet Printer: A machine that prints text and/or images on to paper using microscopic blasts 
of ink from a liquid reservoir.
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Input Device: Any device that generates input for the computer, such as a keyboard, mouse 
or scanner.

Kilobyte: A thousand bytes. Abbreviation: KB. 

Laser Printer: A device for printing text and/or graphics, using a laser beam to fuse micro-
scopic black powder onto paper

LCD: (Liquid Crystal Display) is a technology used in everything from digital wristwatches to 
flat screen computer monitors. It eliminates the picture tube, and there most of the size and 
weight of a CRT screen. 

Megabyte: A measure of electronic memory. One MB equals 1,048,576 bytes.

Megahertz (MHz):  Speed at which a computer runs. While a general indicator (the higher the 
number, the faster the computer) many other factors which factor into a computer's speed.

Memory: Electronic circuitry where a computer operating system can temporarily store pro-
grams and data that it is processing. 

Microprocessor: The main 'brain' of the computer. This is the chip that reads the software 
and translates it into useful instructions. 

Modem: A device that allows a computer to transmit information over telephone lines by con-
verting between digital and analog forms of data. 

Monitor: A video or computer display device. Also called a CRT (cathode-ray tube).

Mouse: Handheld device which allows user to move the screen cursor or pointer. Moving a 
mouse causes relative change in cursor location. Clicking selects an item or command. 

Operating System: (OS) The software which teaches the computer how to be a computer. 
The OS tells the computer how to display text, menus and icons, when to beep, etc.

Output Device: Any device that displays information from the computer, such as a monitor, 
printer or speaker.

Peripheral: Any machine that is attached to a computer, such as a scanner or printer.

Platform: Type of computer, delineated by OS. Macintosh, Windows and Unix are 3 types.

RAM : "Random Access Memory"; computer memory which allows any item in it to be ac-
cessed directly without reading through other items. RAM is commonly used to mean "main 
memory", the memory available to programs. 

Read: The process by which a computer gathers information from a disk or hard drive and 
stores it into memory.

Removable Media: Any type of computer storage device where the storage media can be 
taken out of the machine that uses that media. A Thumb Drive can be removed from a com-
puter; it is therefore removable.
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Resolution: Quality of image on a computer monitor or printed page, usually expressed in 
dots per inch (DPI); the higher the resolution, the sharper the image appears.

ROM: "Read Only Memory"; an area of a computer's memory which can be read from, but 
not altered, or written to.

Scanner: A device which digitizes printed text or images so that they can be processed. This 
is one way pictures may be input into a computer.

Software: A set of instructions to be executed by a computer. Two main classifications are 
system software (e.g. operating systems such as Mac OSX or Windows) and application soft-
ware (e.g. word processing or e-mail programs) which people use directly to perform tasks.

SSD (Solid State Drive): A new alternative to a traditional hard drive. A SSD has no moving 
parts and is much faster than a hard drive.
 
Terabyte: A thousand gigabytes, or one million megabyesv. Abbreviation: TB. 

Thumb Drive: Small storage device which plugs into computer's USB port. Acts like a mini-
hard drive, but with no moving parts. Also referred to as a jump drive or flash drive.

Trackball: A device which allows a user to move the screen cursor or pointer. The user spins 
a sphere mounted in a stationary base. It looks like an upside-down mouse.

Trackpad / Touchpad: A flat tactile sensor that can translate the motion and position of a 
user's fingers to a relative position on the operating system which is outputted to the screen. 
Touchpads are a common feature of laptop computers.

USB: Short for Universal Serial Bus, it is a type of connector used to plug in keyboards, mice, 
printers, thumb drives, and scanners into a computer.

USB-C: The newest standard in connectivity. It can carry power, video and data at high speed.

Video Card: part of the internal circuitry of a computer which governs the output to a monitor. 
Different cards vary in speed and resolution.

Virtual Memory: Allocation of hard drive space as additional memory; slower than real RAM, 
since access to a disk is much slower than access to memory chips. 

VRAM: "Video RAM"; special memory chips which store the screen display. Generally, higher 
VRAM means better screen resolution and more colors available on a computer's  monitor.

WiFi: Wireless communication between a computer and a network, which is then in turn con-
nected to the internet.

Write: The process by which a computer places the contents of its memory onto a disk or 
hard drive.  When a file is saved, it is written to a disk.
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How the Computer Computes
At its simplest, a computer is a device that manipulates information, sometimes also called 
data. Information can and does take many forms. There are two ways to represent informa-
tion. Information that is continuous is said to be analog. Think of a sweep second hand on 
a clock, which smoothly glides its way around the numbers. The second hand moves past 
a number, and moves through all the fractional elements of time in-between any 2 seconds. 

Digital information is restricted to a finite set of values. Think of a digital watch; the hours dis-
play is either one number (say 10) or the next (say 11); nothing in between. An analog clock 
hour hand moves continually from 10 to 11. Digital information in its simplest form is called  
binary. Think of binary information as a light switch; it is either off (represented by a  0), or on 
(as represented by a 1). 

Computers use binary information for several reasons: 

•	 Simplicity: It is the simplest, most compact and least ambiguous way to express informa-
tion about something: for example, binary data could be used to express the  condition of 
a light bulb; 0 means "the light is off", 1 means "the light is on".

•     Expandability: It is easy to build on and expand. You can use two binary values together 
to represent  the status of two light bulbs.

•     Clarity: Errors are reduced when a value can only be 1 or 0; the computer knows there 
are no values in-between.

•     Speed: Computers make millions of decisions a second, and these decisions are easier 
to make when the number of values is small.

Hardware and Software 

A computer is made up of hardware and software. Neither one would work without the other. 
In some ways the analogy can be made to humans that the hardware is your body and the 
software is your mind. If the processor is the computer's "brain" then the software is what that 
brain "thinks". 

Each and every thing that happens inside the computer is controlled by some form of software: 
from spreadsheets, games and other applications, to the device drivers that tell your hardware 
exactly what it has to do to make them work properly. 

Continuing the analogy to the human body, it is important to realize that much the way human-
ity is comprised of both the physical and mental, a computer is nothing without both hardware 
and software.
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Try this: sort the following letters into alphabetical order: G B Y R V O. Most people can perform 
this task in 5 to 10 seconds. A modern computer can do it in about one billionth of a second!
Is the computer smarter? No, not even close! In fact, the computer doesn't know how to sort 
anything at all. A processor only understands a few limited instructions, which are usually quite 
primitive. For example, a processor can multiply two numbers, or make a decision based on 
the result of comparing a number against another one. All programs you use on your computer 
are built from these mathematical "building blocks", even though their complex appearance 
makes this difficult to believe.

To get the computer to be able to sort the letters, someone has to write a program that is 
constructed from the processor's simple building blocks and performs the task that is needed. 
Once this is done, the computer can do the work so quickly because it has such raw speed: 
processors can execute many millions of instructions per second. The computer is not some-
thing to be compared to a genius, but more to a hard worker that has to be shown specifically 
how to make something but then can make it with lightning speed.

Computer Language 

The only languages that computers understand is their own binary machine language. So for 
example, simply to tell the computer to add the numbers 181 and 207 together, the command 
might be "01101001 00110100 10110101 11001101". Who could write a 3D action game like 
that? Nobody, which is why a different method was invented to tell the program what to do.

Higher-level languages act as a "compromise" between what the computer understands and 
what the human programmer understands. They are not like natural spoken languages, but 
they use symbols that are relatively easy to learn. 

For example, in a high-level language, the command to add those numbers might be "X = 181 
+ 207". C, C++, BASIC, FORTRAN and Java are examples of these types of languages.

But how does the computer know what to do with "X = 181 + 207"? It doesn't. A special pro-
gram called a compiler is used to translate (or compile) the high-level language instructions 
into a form the computer. Here is an example of a high level program which multiplies two 
numbers together.
				  
						      on mouseUp
 						        ask "input a number"
  						        put it into x
  						        ask "input a second number"
  						        put it into y
  						        put x * y into Z
  						        put x & " times " & y & " = " & z  into cd fld 1
						      end mouseUp



Page 30 Introduction to Computers for Teachers

What Happens When You Press A Key
To illustrate how the computer works, let's take a very simple example. Let's suppose you are 
working in your word processor and you type the letter "M". Here's what happens, in general 
terms, when you press the "M" button: 

•The keyboard sends an electrical signal, called a scan code, to the computer saying that a 
button was pressed.

•The keyboard controller interprets the scan code and determines that the letter pressed was 
an "M". It stores this "M" in a special memory location until the processor is ready to deal 
with it.

•The controller sends a signal to the processor, called an interrupt. An interrupt tells the proces-
sor that some part of the computer has information for it to process and wants its attention. 
In this case, the keyboard controller wants the processor to look at the key you just pressed.

•The processor is almost always doing many things, sharing its time among many tasks. As a 
result, most every event must wait its turn. The processor services interrupts based on their 
priority. When it is time to deal with the keypress, the processor routes it to the program for 
the operating system that you are using.

•Assuming you are using a multi-tasking operating system like Windows, the operating sys-
tem software decides which window you pressed the key in and sends a message to that 
window telling it a key was pressed.

•The window decides what to do with the keypress. Since in this case it's your word proces-
sor window, and the key you pressed was an ordinary letter, the word processor will add 
that letter to its working area for the file you have open. The letter will take one byte of your 
computer's memory (RAM). Other keys could be handled differently (for example, if you 
pressed the key to tell the word processor to exit).

•The window will then call the operating system to display the letter on the screen.

•The operating system will display the letter on the screen by adding it to your video card's 
video memory.

•The next time the video card refreshes your monitor (re-displays what is in its video memory) 
the letter will appear on the screen. 
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Inside the Computer

Today’s computers are made up of hundreds of 
thousands of parts. The majority of these parts, 
electronic components called transistors, are built 
into the few dozen solid state chips that make 
up the brains of the computer. Invented in 1947 
(pictured right), the transistor replaces the vacuum 
tube and makes the computer possible. Vacuum 
tube computers were built in the 1940’s, but they 
were house - sized and enormously expensive. 
Using vacuum tube technology, a personal com-
puter would be the size of a city block. 

Inside a computer is the motherboard. Soldered onto the 
motherboard are the chips, cards, battery, fan and other 
components which make up the brains, memory, and most 
of the other electronic circuitry of the computer.  We will not 
spend time on how or why they are put together as they 
are, only on the effect they have on you, the user. Recent 
advances have lead to 'computers on a chip', where all 
needed components are embedded into a single chip.

Some  processor chips, have, in effect, chips 
within a chip. About a square inch in size, these 
CPU chips contain microscopic transistors. The 
Apple M1 chip, for  example,  contains 8 cores 
(processors) and 16 billion transistors. It can 
compute up to 2.6 teraflops. 

A 1 teraFLOPS (TFLOPS) computer system 
is capable of performing one trillion floating-
point operations per second. To match what a 
1 TFLOPS computer system can do in just one 
second, you'd have to perform one calculation 
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The computer receives information from input devices, the processor processes it, and it is 
fed back to the user through output devices. This cycle (input - process - output) would not be 
possible without a holding place for the information. This holding place is known as memory. 
There are  three  types of memory used by your computer; RAM, ROM and VRAM.

Memory is the electronic holding place for instructions and data.

Random Access Memory (RAM) is the primary working memory that holds data and instructions 
while the computer is turned on. RAM can be thought of as the memory that the computer uses 
to remember and  perform  instructions given to it. RAM can be written to and read from. But 
the most important thing to remember about RAM is that if you do not save the information in 
RAM to a storage device (such as a floppy disk or hard drive) before you turn the computer 
off, the information in RAM will be lost.

Memory

Today's computers have from 4GB to 32GB of RAM memory. The operating system, loaded 
when the computer is first turned on, uses up to 2 GB of memory. There is a finite amount 
of RAM available to the computer for remembering things. If I want to load a dictionary, an 
encyclopedia and a music program along with a word processor, a computer may not have 
enough RAM to remember all those millions of lines of instructions that make up each program. 
A "not enough memory" message may appear on screen. To avoid this problem, only load 
the programs you wish to work on at any given time. When a program is quit, the computer 
forgets those instructions, freeing up that block of memory for other programs. 

Read Only Memory (ROM)  is more straight forward. ROM is built in memory that permanently 
stores instructions and data. The instructions and data in ROM are created when it is manu-
factured and it cannot be changed. This information is used by the computer to help during 
the boot up process.
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You can use System 
Properties to view and 
change set t ings that 
control how your computer 
uses memory, as well 
as informat ion about 
hardware and the speed 
of the CPU.

On a Macintosh, clicking 'About This Mac' 
in the Apple menu displays the amount 
of memory, processor speed, and what 
version of the OS is being used.

In Windows 8, right-click the Windows icon, then click 'System'. The vital statistics about your 
computer will be displayed

In Windows 10 you can easily 
view basic system information 
like Windows edition, proces-
sor and memory configuration 
and computer name. 

View basic system infor-
mation, right click on "Start 
Menu" and click on "System" 
in pop-up menu to open the 
"System" window.
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On a Macintosh, display (monitor) 
settings are in the System Pref-
erences program (choose Sys-
tem Preferences from the Apple 
Menu). Colors are always set to 
the maximum possible; color ad-
justments include brightness and 
calibration, for color accuracy with 
different monitors.

The third type of memory, VRAM, stands for Video Random Access Memory. This dictates the 
resolution and color capability of your computer's video monitor. Some computer systems let 
you change the number of colors displayed on-screen. Most computers allow for the adjustment 
of resolution - the scale of the images displayed on-screen.

In Windows 10, click the Gear icon, then click 'System', then 'About', then 'Related Settings'.  
Other information about the computer can be found on the 'System' screen. 
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On Windows 7, 8, and 10 computers, the color is set by right-clicking on a empty 
space on the desktop and clicking on Screen Resolution. The same setting can be 
accessed through the Windows control panel.

1. Right click on an empty 
space on the desktop and 
click on Screen Resolution. 

2. Click on the Advanced settings link.

A list of available screen resolutions and color (bit depth) will appear. 
The currently active screen size and color depth is highlighted. 

Windows 10 Display options

3. Click on the Adapter tab, 
and on the List All Modes 
button.
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Another type of “memory” is storage memory - which refers to the amount of space available 
on the computer's hard drive to store programs and documents. This may be a spinning disk 
hard drive or a solid state hard drive. SSDs are faster, more dependable and more expensive.

Think storage memory it as a big filing cabinet. Hard drives come in a variety of sizes, from 
256MB in older computers to 4TB (4000 Gigabytes) on new machines. The operating system 
may take up to 10GB of storage space. Microsoft Word by itself takes over 1GB of hard drive 
space. Other programs, once loaded onto the hard drive, also take up storage space as do 
files saved to the hard drive. When you save a word processing document, a photo from the 
web or save anything else, hard drive space is used. When a hard drive is full, you either have 
to throw something away to make space, or store new files somewhere else, like another hard 
drive or cloud storage. Because of the way hard drives store data, they work best when they 
are less than 3/4 full.

512GB hard drive space  - 
12GB saved movie = 

500GB hard drive space 
remaining

If a graph were made of a 512 GB hard drive, the different types of files might look like this: most 
of the 'filled' space is taken up with the OS files and programs, leaving most of the remaining 
storage for user-created documents, such as word processing files, photos, music and movies.

Storage Memory
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To check the capacity and available 
free space of the hard drive on a 
Macintosh, right-click the Hard Drive 
icon and then choose 'Get Info' from 
the File menu.

To check the capacity 
and free space of the 
hard drive on any Win-
dows computer, double 
- click the My Computer 
icon to display a list of 
drives. Drive C is typi-
cally the main (or only) 
hard drive. 

Right - Click its icon and 
choose 'Properties' to 
show its capacity and 
(remaining) free space.

For Windows 8 and 10, right 
click the Windows icon on the 
bottom left of the screen and 
choose "Disk Management" 
from the pop up menu.

In Windows 10, click the Windows icon then 
Settings, then System, then Storage.



Page 38 Introduction to Computers for Teachers

The Central Processing Unit (CPU) is  the main compo-
nent of a computer where most calculations take place; it 
is also called the microprocessor. Most computers have 
a CPU made by Intel, IBM or AMD. The speed, or clock 
rate, of a CPU is normally determined by the frequency 
of an oscillator crystal. In very general terms (there are 
many other factors which determine a computer's overall 
speed), the faster the processor, measured in mega-
hertz (MHz), the better. A faster microprocessor means 
a computer can perform all its tasks more quickly, from 
displaying text and images on screen to re-calculating 
spreadsheets and surfing the web. 

The clock rate of a computer is only useful for providing comparisons between computer chips 
in the same processor family. A computer with an Intel Core CPU running at 3.2 GHz will be 
about twice as fast (running programs) as one with the same CPU, memory and display run-
ning at 1.6 GHz.  Apple has just introduced the M1 CPU chip, prompting a revolution in speed 
and power consumption for their Macintosh computers.

In practical terms, newer computers (less than 3 years old) will deliver all the speed needed 
for everyday tasks. As new models from various manufacturers appear, each tries to outdo 
the rest, and microprocessor clock speed is an easy benchmark on which to base advertising 
machine performance. 

In truth, there are several different ways to measure speed, and several factors (not just the 
MHz or GHz of the chip) must be taken into account. 

As you can see by the chart, the 
trend is to yield faster and faster 
processing power with each new 
generation of processor chip.

The Processor

Apple is transitioning all their 
devices from Intel brand CPU 
chips to their own designed and 
manufactured chips.
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Project 4:	 Inside Your Computer
To fill out and submit this form, please go to the Inside Your Computer Survey link on the course website. I have copied the survey here 
merely for reference; you will submit your responses via the Course Website.  A copy of your completed form should be e-mailed to you 
after submitted.  A couple brief, succinct sentences should suffice

What kind of computer(s) are you using to complete this course? What Operating System?

How big is the hard drive (the C: drive on a Windows computer)? 

How much memory (RAM) does the computer 
have?

How much free space (in GB, or measured and 
expressed as a percentage) is available on your 
hard (usually the C:) drive?

Is the computer you are working on connected 
to a printer? How? (hardwired, WiFi, or none)

What type of mouse are you using (i.e. track-
pad, mechanical, optical, wireless)?
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The operating system, also called the OS, is the most basic software a computer uses. Your 
computer relies on its operating system to manage all of the programs installed on it and all 
the hardware devices connected to it. Without a functioning operating system, no other pro-
gram or device will run. 

The operating system is essentially a traffic cop, responsible for the flow of information through 
your computer system. It dictates how data is saved to your storage devices, keeps track of 
your file names and locations, and controls all of the devices connected to it. 

When you turn on your computer, the operating system is read from the hard drive and auto-
matically loads. When other programs are started, the operating system continues to run in 
the background. All modern operating systems provide the following functions:

•initializes (prepares for use) the hardware of the computer system (boot or startup) 
•provides basic routines for device control (device management) 
•provides for the management, scheduling and interaction of tasks 
•maintains file systems (file management) 
•provides software toolboxes which programs can use to perform tasks
•provides a graphical user interface (GUI) by which the user interacts with the OS

 
There are three major operating systems in today's computer-using schools - Microsoft Win-
dows, Apple Macintosh and Google Chrome*, each with several different variations, or versions. 
A computer running Windows might have XP, Vista, 7,8 or 10 (Microsoft skipped number '9'). 
A Macintosh computer could be running OSX (10.6 through 12.3). Apple has dropped the 
OSX numerical designation, now calling their operating system 'MacOS' with catchy names 
(ie macOS Monterey).
 
All these variations do essentially the same things; it is just a matter of learning what you want 

The Computer's Operating System

* Google Chrome (Chromebook) is covered in another of my courses, TEC 944
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To boot up a Macintosh computer, press the power button, located on the up-
per right hand corner of a laptop or the rear bottom-left corner of iMacs. The 
power button is round with a short vertical line at the 12 o'clock position - this is 
the standard icon for power on/off. Sometimes peripherals, such as monitors or 
printers, have a separate on/off switch.

The operating system starts loading from the hard drive into the RAM when the power but-
ton is pushed. After the operating system is loaded, the computer performs a check to make 
sure all peripheral hardware (input, output and storage devices) are properly attached to the 
computer. As soon as all devices are verified and the computer has booted, it is ready to ac-
cept input from the user. 

Shutting down the computer turns the system off completely. To safely shut down 
the Macintosh computer, click on the Apple Menu and select Shut Down. The 
computer will completely shut down all open windows and turn itself off. You may 
also press the Power Key and select SHUT DOWN from the dialog box. 

Power
Button

How to Boot Up a Macintosh (Start the computer)

How to Shut Down a Macintosh (Turn off the computer)
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Now you are ready to learn how to boot up (to load an operating 
system into the computer's random access memory) a Windows 
computer. Different computer makers put the "on" button in different 
places, and they are often different shapes (round, square, rectan-
gular). However, for the most part, you can identify the "on" button 
by looking for one of the symbols to the right. The symbol will be 
located on or below the button. 

Pushing the power button initiates the loading of the operating system into RAM. After the 
operating system is loaded, the computer performs a check to make sure that all peripheral 
devices (input, output and storage devices) are properly attached to the computer.  This boot 
process is displayed on the screen as a notice or animation. 

As soon as all devices are verified, the computer is ready to accept input from the 
user. Peripherals, such as monitors or printers, may have a separate on/off switch.

Shutting down the computer turns the system off. Click on the Start Menu, move 
the mouse pointer up to select  "Shut Down" and click once. 

    How to Boot Up a Windows Computer (Start up)

How to Shut Down a Windows Computer (Turn it off )

On Windows 8 and 10, right click the Windows icon at the lower right of the screen. In Tiles 
mode, click 'Power', in desktop mode, right-click and choose 'Shut Down or Sign Out'.
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Graphical User Interface: What is GUI (Gooey)?
In ancient computer times (or about 30 years ago) computers were controlled by command 
line instructions. There were no mice. There were no menus. If you wanted to copy a file or 
change a setting, you had to use a programming language called DOS. In 1984 Apple Com-
puter introduced the Macintosh and with it, the mouse-driven Graphical User Interface (GUI). 
The concept is borrowed from educational theory; it is easier to manipulate real-world objects 
(such as colored wooden building blocks) than it is to work with abstract symbols (such as 
numbers and equations). Just as it is easier to teach a child addition with blocks, it is easier 
to control a computer with visually representational icons. If you want to throw away a piece 
of paper, pick it up and drop it in the trash can. In DOS you would have to type something like 
C:\del filename.txt to throw away the document. When a child is counting with blocks, he or 
she knows those blocks are real; they can be moved, repositioned and arranged at will. When 
working on the computer the same is true. Icons, folders and files can be moved, arranged 
and organized just like their read-world counterparts. This is a vital concept to grasp.

The main parts of a graphical user interface are icons, windows and menus. There's a dif-
ferent icon for each kind of item on the desktop. For example, a program icon is an item you 
can open and use to create documents. Most programs and documents have their own unique 
icons, so you can identify which program created each file or document. For example, the 
document below was created in Microsoft Word - the 'W' is a unique icon used only by Word.

Hard Disk    Programs     Document     Folder

Rather than filling up the screen with labeled but-
tons, the GUI uses menus, or more accurately, 
drop down menus. To the right is the menu for 
VIEW when looking at files in a Windows pro-
gram. They are visible only when the word VIEW 
is clicked. The VIEW menu, along with several 
others, appear on the MENU BAR at the top of 
each window. 

Most programs feature 
'tooltips'. Hovering the 
mouse over a button or icon 
will reveal its name.

To open an icon: Double-click it. (Click the icon 
twice quickly, being careful not to move the mouse 
between clicks.) When you open an icon, its contents 
appear in a window (more about windows in a bit).
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The First Thing You See: The Desktop

When you boot up a Windows OS computer, the desktop will display the Task Bar (generally 
located at the bottom of the screen) and, at a minimum, the My Computer and the Recycle 
Bin icons. In the image below, you will notice that at the bottom there is a bar with words and 
icons. This bar is the Task Bar. At start up, the Task Bar will contain the Start button and the 
program status information. 

When you boot up a Macintosh, the desktop will display the Menu Bar and, at minimum, the 
Hard Drive and the Dock icons. At the very top of the screen you will see a bar with words 
and icons on it. This bar is called the Menu Bar. The Menu Bar serves as the home base for 
all menus that are available to the user. The dock allows easy access to programs and files.

Tiles View         Task Bar     Program Status Information

Windows Taskbar: adding items to the taskbar is referred to 
as pinning. Removing them, unpinning.
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The Macintosh Desktop: A Detailed Look

In the left-hand corner of the Menu Bar you will see the Macintosh Apple icon. This icon rep-
resents the Apple Menu. The Apple menu allows quick access to system settings and other 
computer-wide functions, such as Shut Down.

The dock in OSX allows the user to place shortcuts to frequently used programs and docu-
ments within easy reach from any program.

System Preferences contains settings for most of the 
computer's operations, from changing the desktop 
picture to adjusting the display and sound settings.

Move the cursor over the an icon on the dock, 
and its name will be displayed. Icons representing 
progams can be added or subtraced from the dock 
simply by dragging them on or off.
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The Edit menu also exists in nearly every program. Here you 
can Cut, Copy and Paste information from a document, such 
as a paragraph from a word processor document or a photo-
graph from a web page. Note the keyboard shortcuts are part 
of the menu. 

The 	   symbol represents the 'Apple' key, or Command key.

Note that some menu items are gray (grayed out), and some are black. The gray items are 
inactive, and you can't use them. For example, in the Finder File menu, the Duplicate item 
can not be used at this time because there is no file or folder selected to duplicate. Think of 
it as someone asking you to do 'something' - without knowing what 'something' is, it is better 
to do nothing; the program functions in the same way.

The darker menu items are active, and will 
perform the function normally when com-
manded.

The menu items that have an ellipses be-
hind them (...) will open a dialog box when 
selected, giving you options and choices. 
The Print... menu will open a dialog box 
allowing you to select what printer to use, 
the number of copies, scale, orientation, etc.

Next in line is the File menu. Some items, such as Open, Close 
and Print appear in every program you will use. Other items, 
such as Get Info and New Folder, appear in the File menu 
only in the Finder. This is an example of a contextual menu; 
one that changes in accordance with the program.

Here the File menu from the Firefox 
web browser is compared to the 
OSX Finder, demonstrating how 
the menus change from program to 
program.
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The View menu allows you to look at the file information 
presented on screen in a variety of ways. You can arrange 
and view a list of word processing documents, for example, 
as an alphabetical list or chronologically or by predefined 
order of importance. These are basically housekeeping 
functions; they don't directly relate to how work is done, but 
rather how you wish to file and view documents and files 
on the hard drive.

The Help menu offers contextual help with the finder 
and most other programs. Choosing the Help Center 
opens a good, basic primer on using the Macintosh. 

Icon view

List view

Column view

Double-clicking the Macintosh HD 
icon will show one of four views.

Cover Flow
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The Windows Desktop: A Detailed Look

The DESKTOP, your Windows work-
space, appears as a colored background  
or picture (wallpaper), and contains 
icons which open programs, files and 
directories of files. 

The icons displayed depend on choices you made 
at installation, but should always include COM-
PUTER (gateway to your computer's drives) and 
RECYCLE BIN (a temporary 'trash can' for storing 
files you intend to delete).

Windows 8 introduced Tiles, a way to view your computer's 
files and programs as large, movable icons. This scheme 
hides the desktop, simplifying the selection of programs.

Tiles View           Task Bar           Program Status

Double - clicking these icons will open the programs or files they 
represent. Right - clicking them will open a pop-up menu with a va-
riety of options. Right - clicking the desktop will also open a pop-up 
menu with icon-related options such as arrange and line up icons. 
By dragging these icons, you can move them elsewhere and ar-
range them as you wish. 

You can switch back and forth between the 
traditional desktop view and the tiles view. 
Windows 10 shows both views (tiles and 
icons) at the same time.
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If you have more than one program open at once, you 
can switch between programs by using the Task Bar icons 
which appear at the bottom of the screen (in desktop 
mode).

Clicking on the 'PC Settings' icon (in tiles view) allows access to all the com-
puter's technical and account information. At the bottom of the settings list is 
a link to the Control Panel.

The Control Panel is where you can con-
figure your computer and its hardware.

With Devices and Printers, you can 
set up your computer to talk to various 
printers.

With Search, you can search for pro-
grams, files, and folders.

Help and Support provide you with a 
variety of means for getting help with 
Windows and its accessories.
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The Help menu offers contextual help with the finder and most other programs. Choosing 
Get Help from the Start menu will display a new window showing the equivalent of the user's 
manual. In it you can find step-by-step directions and explanations of common Windows 
commands and procedures.

In Windows 10, click the Windows icon, then 
the Get Started icon to show the Help sys-
tem, including how to use the new Windows 
10 features.
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Working with Windows On A Macintosh Computer
Information on your computer appears in boxes called 
"windows." This is true whether it is a computer run-
ning the Macintosh OS or the Windows OS. When 
you hear "Windows on a Macintosh" or "Macintosh 
windows" it could be a point of confusion (it is possible, 
using a software program, to run the Windows OS on 
a Macintosh). This discussion concerns itself with the 
rectangular areas which contain the visual representa-
tion of folders and files. Think of a window as a detailed 
label on the front of a filing cabinet; it tells you what is 
stored inside. To open a window, double click a folder icon, such as HARD DRIVE. A window 
will appear revealing the contents of the hard drive. This action also works for folders (double 
clicking a program or document will launch a program). You can also think of a window as 
a piece of paper on your desk. You can put the paper whereever you want, file it away in a 
drawer, or fold it in half so it takes up less room on your desk. 

Here are the parts of a Macintosh Finder window:

By turning the Toolbar control on or off, 
you can view the window content as 
simple icons (above) or view the content 
by icon, list, column, or cover flow (right). 
Mousing over a button will display a short 
description of what that button does.

Close Window Minimize Window Maximize Window

Sidebar

Icon Size Control

Drag any corner to resize window
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MacOS (Operating System 10), can dis-
play windows in many different formats, 
including list view and icon view. In list 
view, clicking a column heading will resort 
the list. 

A customizable "Sidebar," 
down the left-hand side, gives 
one-click access to most files.

Active and inactive windows: you can distinguish the active window from the inactive window 
by looking at the title bar, which is grayed out. Here is the same window in active mode (above) 
and inactive mode (below). Simply click any part of an inactive window to activate it.
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Working With Windows in Windows

The Windows OS window includes the title bar, the minimize button, the maximize button, the 
close button, the menu bar, and scroll bars (vertical and horizontal) if needed. Windows can 
be resized by mousing over an edge or corner, then dragging in or out. In the next section, 
you will learn how to perform the basic Windows OS window operations. Think of a window 
as a detailed label on the front of a filing cabinet; it tells you what is stored inside. To open a 
window, double click a  folder icon, such as HARD DRIVE (Local Disk). A window will appear 
revealing the contents of the hard drive. This action also works for folders (double-clicking a 
program or document will launch a program). You can also think of a window as a piece of 
paper on your desk. You can put the paper wherever you want, file it away in a drawer, or fold 
it in half so it takes up less room on your desk. 

Title Bar Minimize
Button

Maximize
Button

Close
Button

Menu Bar

Scroll
Bars

Sizing
Edge

View by 
icon or list
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The image below displays two windows. You can distinguish the active window from the inactive 
window by looking for the window with the darker color - that will be the active window. The 
window in the upper left hand corner of the image is inactive (the "untitled - Paint" window) 
and the window at the bottom of the image is active (the "Microsoft Word" window). To make 
a window active, click anywhere inside the window or on the title bar. As a window becomes 
active, the Task Bar button for that window will appear darker as well. Notice the task bar at 
the bottom of the images.

Active Window

Inactive Window

Active Window

Inactive Window

In Windows 8, the close 
button is red in active 
windows, grey in inac-
tive.

In Windows 10, the close 
box is slightly darker in 
an active window. The 
Colored 'X' has been 
replaced by a simple 'X'.
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How to Start (launch) a Program
There are several ways to launch a Windows program, such as the built-in word processor, 
NotePad. The method you choose to use at any particular time will depend on where you are 
starting from.
 

From the Windows Menu:

In Windows 8, click the down-arrow but-
ton at the bottom left of the Tile screen. 
An alphabetized list of all programs will 
be displayed. The program can be opened 
by double-clicking, or if you right-click a 
desktop shortcut can be created.

In Windows 10, click the Windows icon 
in the lower left corner, then click the 'All  
apps' link. A list of programs will appear in 
the sidebar. Right-clicking an icon reveals 
a range of options.

From a desktop shortcut:

1. Find the shortcut icon on the desktop*

2. Double click the icon to launch the program

* - Windows comes with some shortcuts already on the desktop, 
but it is possible to add your own.

Right-clicking on a program will open a 
menu, letting you create a desktop shortcut.
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How to Start (launch) a Program
There are several ways to launch a Macintosh program, for example, the Dictionary. The 
method you choose to use at any particular time will depend on where you are starting from.

From a desktop shortcut (Alias):

1.	 Find the shortcut icon on the desktop. Macs come with some 
shortcuts already on the dock. It is possible to add your own 
shortcuts. You can also add a program shortcut (or alias) to the 
desktop, or to the dock. The small arrow at the bottom right of an 
icon indicates it is an alias.

2.	 Double click the icon to launch the program (in this case, the 
Dictionary).

From the Hard Drive:

1.	 From the finder desktop, double click the 
Hard Drive icon.

2.	 You will see the contents of the Hard Drive. 
Find the Applications folder and double-
click to open it. Locate the Dictionary 
program, then double-click to open.

If your program is present on the dock, click once to open. A small indicator will appear 
beneath the icon, indicating the program is active (opened). To add a program to the dock, 
simply drag its icon onto the dock from the Applications folder. In this illustration, the Finder 
and the Preview program are both open.

Applications
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As described earlier, a hard drive is like 
a huge filing cabinet. Within it are many 
"drawers" called folders or directories. 
When creating a document, perhaps a 
note you want to send to parents, you 
have the ability to 'file' that note any-
where you wish on the hard drive. 

This ability to navigate through the fold-
ers of your hard drive (or others, if your 
computer is on a network) is a very 
important concept. If you are a very or-
ganized person, you might like to create 
and label a special folder called "letters 
to parents" and place that folder in a 
drawer called "school correspondence". 

You would save the note with a title 
something like "Spring 2019 letter to 
parents." To the right is a hierarchical 
diagram of how you might organize and 
save your school documents.

This Windows 10 screen shows the location 
of a document (Zero Gravity) and several 
user created folders, each holding at least 
one document as indicated by the icon.

Keeping Track of Documents
My Computer

C: Drive

Fall 2022 Letter
to Parents

Parents22 - 23

School

If you are in a hurry or don't mind where you store your document, it will probably be placed 
in the default location (i.e. the Documents folder) or the same folder where the original docu-
ment was located. The bottom line: be organized! You will learn in a bit how to create folders, 
name and rename files, and move them where you want.
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Project 5:	 Treasure Hunt
In this assignment you will practice navigating to and exploring the contents of folders and files.  
To fill out and submit this form, please go to the Treasure Hunt Survey link on the course website. I have copied the survey here merely for 
reference; you will submit your responses via the Course Website.  A copy of your completed form should be e-mailed to you after submitted.  

Go to the course website, www.intro.steveyoungfpu.net

If you have not done so, locate the 'Course Forms & Resources' link on the 
course website. Clicking on the link will download a .zip file to your computer. 
Double-clicking the file will create a folder on your computer containing all 
the course resources, including those for this assignment. 

How many folders are there in the TEC 923 Resources 
folder?

Inside the folder called CARS, how many files are there? 
List them.

What is the name of the file in the DOGS folder?

How many files are there in the COOKING folder? 

In what folder would you find the sound of a flute?

Windows Icon Macintosh Icon
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Word Processing is the ability to create written documents using a word processor. Word 
processing developed as a specialized program on mainframe computers during the 70s, 
as online computing with the use of personal terminal devices having keyboards and display 
screens became more common. These programs evolved from text-based editors used by 
programmers and computer professionals. 

Microprocessors and, in the late 1970's, the ability to place intelligent devices on the desks of 
workers at a reasonable cost, including cheaper and smaller printers, led to the introduction of 
machines dedicated to "word processing". These were primarily aimed at typists, particularly 
those in centralized typing pools where other workers sent handwritten notes or Dictaphone 
tapes to be transcribed into documents that could be printed and returned for reviewing. Con-
siderable time saving economies were achieved by word processing operators. This resulted 
from:
    		  * the faster typing speeds achieved by as a result of electronic keyboards
    		  * the assistance of word processing software for functions like layout and spell check

Word Processing is revolutionary because it bypasses steps that for centuries have been 
handled almost exclusively by trained professionals. Design, typesetting, paste up and print-
ing - these skills are now in the hands of anyone who has learned to use a computer. Before 
word processing, a writer would compose copy, a typesetter would produce printed text and 
a designer would cut up the columns of type strip in graphics and lay out the pages on art 
boards. Then those boards would be sent to professional printers. With a word processing 
program, the final laser printed pages are sent directly to a printing house or simply photo-
copied by the user. 

The essence of the process known as word processing goes by the acronym wysiwyg for 
"what you see is what you get". Whatever appears on the screen is very similar to what the 
printed page will look like. At any time during the process the printer can provide a good 
quality printout that serves as either a draft or a final page, a huge time saver over traditional 
methods. 

Word processing has made it much easier to revise and rewrite a document. Instead of re-
typing a paper with inserts and changes, the author can open the document on  the computer 
screen and just type the changes. Since the revision process is now much easier, teachers 
are finding that their students are excited by the way their work looks and are willing to make 
necessary changes. 

Teachers find that the ability to quickly create informative and even entertaining documents 
to be of great benefit. Teacher-parent communications, class hand outs and even bulletin 
boards take on added value when the message from the teacher is cleanly and professionally 
produced. This can be achieved even by a novice at word processing, with just a little time, 
practice, patience and effort. So let's get started!

Word Processing



Page 60 Introduction to Computers for Teachers

  Word Processing Glossary 
Active Window: The window where the next command or action takes place. The active 
window lies on top of other open windows.

Application: Instructions that manipulate information. Also referred to as a program. 

Auto Numbering: Feature that automatically numbers the pages of a document for the user; 
also renumbers pages as material is moved, added, or deleted

Choose: Dragging with the mouse to pick a command from the menu.

Click: To position the mouse pointer and then press and quickly release the mouse button.

Clipboard: A portion of memory that holds the last Cut or Copied selection.

Comment: Feature that allows a user to annotate and create notes in a document without 
changing the text of the document.

Document: A file you create with a program

Double-click: To position the mouse pointer, then press and quickly release it twice.

Drag and Drop: The ability to Drag text and pictures from another document  and Drop them 
onto an existing page. 

Export: Transferring text out of one program to another program.

Filters: A translation feature that allows saving and opening one kind of document to a dif-
ferent program. 

Find and Replace: A feature which allows a word to be replaced automatically throughout a 
document. May be global or selective.

Font: The shape of characters belonging to a particular family of type. Some examples of 
different fonts are  Rosewood, Giddyup STD, HERCULANUM, Comic Sans MS and Terratello

Footer:  Text that appears at the bottom of each page of a document.

Footnote: Material that is printed at the bottom of a page; marked in text by a numbered 
referent.

Hard Copy: A printed copy of a word processor document, usually on paper.

Header: A title or heading that appears at the top of each page of a document.

Highlight: Click on or drag an object or area of a document to make the background or object 
darker or visually distinct. Highlighted objects or areas are referred to as "selected".

I-beam: The shape of the mouse pointer in a word-processing environment. It blinks and 
marks the point where text (or graphics) will be inserted.
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Import: Bringing text or graphics into a program from another program or document. 

Justify: To adjust the spacing within lines in a document, for example, so that the 
lines end evenly at a straight margin. 

Keyboard Shortcut: A combination of keys that can be used instead of having to 
select an item from a menu.

Landscape Orientation: Refers to a page that is printed wider than it is long.

Menu Bar: The horizontal bar below the title bar that contains the names of the 
program's menus.

PDF: Portable Document File - A file format developed by Adobe Systems, Inc., for 
sharing files independently of the application that created the file or the computer’s 
operating system.

Point: The size of letters are measured in points, equal to 1/72 of an inch. (i.e. 36 
point text is 1/2 inch high, 18 point is 1/4 inch).

Scroll Bar: Rectangular shaded area on the right and bottom of a screen repre-
senting width or length of document. Scroll arrows and a scroll box used to scroll 
the document. 

Select: To mark where the next action will take place. Before a command is cho-
sen, items are selected by clicking or dragging the cursor (or I-beam) across them.

Spell Check: A feature which compares the words in a document with the words 
in its dictionary and offers alternatives. In some word processors, this feature can 
be set to automatically correct spelling as you type. 

Style: The visual look of a letter or word, such as bold, italic, underline, etc.

Template: A predefined document with specific style and layout. Use of a template 
saves time and assures a professional looking document. 

Word wrap: A feature that moves text from the end of one line to beginning of the 
next line. 

WYSIWYG: Arcane term for ' What You See Is What You Get'. When what you 
see on the screen is exactly the same as the way it will be printed. This term is 
outdated, as all word processors are now 'wysiwyg'
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Word Processing Programs

Microsoft Word

Google Docs

Apple Pages

There are many word processing program available today, but three dominate the education 
community; Microsoft Word, Google Docs, and Apple Pages. You may use any of these (or 
another if you choose) to complete the word processing assignments.
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This is a generic word processor window. 
       

                            

All word processors share common traits; controls for adjusting the position and formatting 
of text, setting tabs and spacing, inserting graphic elements into a document. Compare the 
three word processing programs below, Microsoft Word, OpenOffice Writer, and CKEditor. 
Notice they have many similarities. Learning one word processor will allow you to use other 
word processors; the underlying concepts and controls are all the same. Some programs 
may have more features than others, but the most often-used capabilities are shared by all.

Ruler
Text Formatting Buttons

Word Processor Controls

Menus

Microsoft Word

OpenOffice.org Writer

CKEditor Document (a free online word processor linked to on the course website)
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Get To Know Your Menus

The items in the menu bar reveal the fea-
tures and possibilities within the program. 
When you open a new program, take sev-
eral  minutes and look through the menus. 
In doing so, you will quickly see the range 
of options available to you. Some menu 
items have a small triangle next to them, 
indicating that a submenu will reveal even 
more options and features.

On this page are the menus for a Google 
word processor document.  You will also 
see many items which will not be covered 
in this introductory course, but which may 
spark an interest to explore more about 
what the program has to offer.

For example, in the Edit menu, there is an item called 
Find and Replace. This feature can locate and 'swap out' 
one bit of text for another. If you are writing a paper on 
insects and don't want to type in 'Psudocalamobius' over 
and over, you can just type 'psm' and then go back and 
have Find and Replace your three letter shortcut with the 
full word. 
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Saving a Document

There are now a range of possibilities when it comes to saving your work. If you are using 
a cloud-based word processor such as Google Docs or Apple Pages, the document will be 
automatically saved to your cloud-based account.

With traditional programs like Word, documents must be Saved or Saved As. Choosing Save 
for the first time will allow you to choose a name for the document and a location on your 
computer's drive to act as a storage location point. Subsequent saves will replace the existing 
named document with the updated version. Choosing Save As will let you save a copy of a 
document under a different name and/or location. In the above illustration, the 'Once Mother 
Said' document will be placed in the 'First Grade Songs' folder which is inside the 'Documents' 
folder. 

Typically if you try to close a word processor without saving, 
the program will prompt you to save your work.  

In Windows, locate and select the Save command. You can then name and place 
your document where desired. Note that in Word you have the option of saving to 
your computer or in Microsoft's cloud service.
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Fonts

A font refers to a type of shape of a 
particular set of letters. Fonts afford 
us the ability to type in a wide vari-
ety of lettering. Two major classes 
of fonts are Serif and sans-serif. A 
serif is the flourish at the end points 
of a letter, as seen here.

R

R
A sans-serif (sans meaning without) 
font lacks the flourish and appears 
more 'blocky'. 

To change fonts, go to the FONT menu. A menu 
will appear with a list of available fonts. Generally 
speaking, no more than two or three different fonts 
should be used in a given document. If too many 
fonts are used, your letter may end up looking like a 

You can also change the size of the lettering. In printing, 
size is measured in points. One point is 1/72 of an inch. 72 
point text will produce lettering 1 inch high, 36 point text 
is 1/2 inch high, etc.. 

Most type you read in books and newspapers is 10 point 
text. To change font size, go to the SIZE menu and select 
a point size. You are currently reading 12 point type, just 
to give you an example.
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Someday software may have the 'brains' to "do what I want, not what I say". Until that time 
we must rely on other ways to 'tell' a computer exactly what we want it to do at any given 
moment. There are literally hundreds of features built in to a word processing program - and 
commands to access each of them. 

For example, let's say we are typing a letter and want a certain word bolded, just as I've done 
here. There are six ways to do this one task. Six ways! This may seem like overkill, but the 
idea is to make the software adaptable to the way you work. Many features  can be turned 
on and off in several different ways. Experiment with each of them, and decide which way is 
easiest for your working style. Here are six ways to bold a word in a word processor document:

1)	 Type in your text, and just before you type in the word you 
wish bolded, mouse up to the STYLE menu and select BOLD. 
Type in the next word. You will notice that it is bold. After you 
type in that word, mouse to the STYLE menu and select PLAIN TEXT to return to normal 
character style. Many features in Google Docs, Word and other programs act on a toggle or 
light switch principle. In this case, once BOLD is turned on, it will stay on until you turn it off. 
The same menu command, BOLD, will either turn bold on or off, depending on its state. There 
are two ways to check whether or not bold is turned on; type something and see if it is bold, 
or look in the STYLE menu and see if there is a check-mark before the BOLD command. A 
check-mark means that bold (or any other feature) is on.

2)	 Type in your text, and just before you type in the word you wish bolded, press the keys, 
Command + B (control + B in Windows). Type in the next word. You will notice it is bolded. 
After you type in that word, press command - B or command - T. These commands are called 
COMMAND KEY EQUIVALENTS. If you look at the STYLE menu, you will see next to the bold 
command. This is to inform you that pressing command - B on the keyboard is the equivalent 
of using the mouse and selecting Bold from  the Style menu. This technique has the advantage 
of not having to remove your hands from the keyboard.

3)	 Type in your text, and just before you type in the word you wish bolded, use the mouse to 
press the B (for Bold) button on the shortcuts palette. You will notice that it is bold. After you 
type in that word, use the mouse to press either the B  button or the T (plain Text) button on 
the shortcuts palette.

4~6)  The last three ways are to follow step 1 or 2 or 3 above after the document has been 
finished. Using the mouse, double click on the word (text, or characters) you want bolded. 
This highlights that word. You can then choose BOLD from the STYLE menu or click on the 
B button in the shortcut palette, or press command + B (control + B in Windows).
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To align text:

There are typically three ways to change the alignment of text - using a menu command or 
an alignment icon.

Justification - Alignment

When typing in a word processor it is not necessary to press return near the end of each 
line, as it is with a typewriter. Word processors have word wrap, which automatically 
starts a new line of text. You will note that each line starts on the left hand margin (this 
paragraph is an example). If you look at the right hand margin, you will note that each 
line ends at a different spot. This is called left justify or ragged justification. This para-
graph is set to full justification. You will note that both the left and right sides of each 
line touch their margin. To do this, the word processor measures the width of each letter 
on a line and adjusts the spacing to spread out or squeeze together the text to make it fit 
exactly the width of a line. Some word processors have a force justify command, which 
will  make a line reach from margin to margin, regardless of the number of words on a line - 
( t h i s  i s  a n  e x a m p l e ) .

Left justify keeps the first character in each line at the left margin.

Center justify lets you center text (usually a title) on the page. 

Right justify is used for numbers of two-column lists 
to create a visually interesting form. 

The Justification (Align) menu 
controls in Google Docs

Alignment icons are nearly identical in, below, Microsoft Word (left) and Apple Pages (right).
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In a word processing document, paragraph indentation is the amount of space between the 
edge of the text and the document's margins. Each paragraph can have its own indentation 
settings. For example, to highlight a quotation, indent the paragraph. 

To change paragraph indentation:

Click the relevant paragraph (a section of text separated from the text above and / or below it 
by a space) then click the Increase indent icon               or decrease indent icon

Indents

Indent icons in Google Docs

Indent icons in MS Word

Indent icons in Apple Pages
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In a text document, you can line text up at specific points across the 
page by setting tab markers at those points. When you press the 
Tab key, the insertion point moves from one tab marker to the next 
(rather than the default, that being every 1/2 inch), and the text you 
type aligns at that point. 

To set a tab, click the ruler at the location you wish to place a tab. 
In Google Docs (top right), a menu shows the available types of 
tabs. Double-click an existing tab icon in Microsoft Word (middle 
right) or right-click a tab icon in Apple Pages (bottom right) to reveal 
tab options. Note: as of this writing, there are no tab settings in iCloud Pages.

Text documents are preset to use single-space lines. You can 
increase or decrease the line spacing using the menu command 
and / or icon; you can set spacing in half-line increments. To set 
line spacing by a more exact amount, use the option dialog box.
In most programs, you can also fine tune the spacing using points, 
or 1/72 of an inch increments.

Line Spacing

Tabs

Line Spacing in Google Docs

Line spacing in Microsoft Word

Line spacing in Apple Pages
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Margins are the empty spaces between the edges of the paper and the working area. They 
are marked by a light gray border called page guides. You can change the preset margins 
for your document. For example, you may want a wider left side margin if you are going to 
hole-punch the document and put it in a binder.

In Google Docs, choose Page Setup from
 the File menu.

Margins

In Microsoft Word, click the Lay-
out tab on the icon ribbon, then 
click the Margins icon.

In Apple Pages, click the Document 
button. In iCloud Pages, 
click the icon.
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You can set up your document so headers or footers are automatically set on every page. 
Use headers and footers to repeat information such as the page number, title, and date on 
every page. 

This will save you time (not having to re-type the information in every time) and give your 
document a finished, professional appearance.

To create a header or footer in Google Docs

1.	 Choose Insert Header or Insert Footer from the Insert menu.

2.   In the header or footer area, type or paste the information you want to use as a header 
or footer. You can use dates, times, and page numbers in headers and footers, as well 
as graphics and text. Note there is also a menu item for page numbering.

Headers and Footers

To create a header or footer in Apple Pages

1.	 Click in the pre-defined header or footer section and add text. On 
a Mac, you can choose to add page numbers. In iCloud, use the 
Paragraph icon and choose  and Page Number.

To create a header or footer in MS Word

1.	 Click the Insert tab on the icon ribbon, then 
click the Header or Footer icon. The small 
arrow next to each icon will show several 
formatting options.
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Page Setup & Printing
The printed page is still an impor-
tant part of our lives. Work done 
on a computer is often printed, and 
you have control of how (and even 
where) it is printed. Two screens 
control these features, page setup 
and print. 

Page setup allows you to adjust 
the scale, orientation, paper size 
for your print job. The page setup 
screen is printer dependent, mean-
ing each printer type and model may 
offer different features. The page 
setup command is in the FILE menu.

The print screen allows you to spec-
ify the quantity and range of your 
print job. You can print one copy or 
many copies of the same document 
(If you have to make many copies, 
I recommend printing one, then us-
ing a copy machine for the rest - it 
is much less expensive, in the long 
run!). 

You can also print all the pages in a 
document or a range of pages, such 
as 'print page 5 to page 5' will print 
just the fifth page of a document. The 
print command is in the FILE menu, 
or sometimes there is a print button 
or keyboard shortcut. 
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The following projects will progressively introduce you to the powerful word processing tools 
at your disposal. You will need to print each finished project to turn in with your packet. Feel 
free to experiment; you can often learn more from 10 minutes of playing than an hour reading 
an instruction manual. 

Keep in mind that it may take several tries to 
'get' a particular concept or technique. Stay 
below your frustration level, but keep trying! 

Feel free to use which ever word processing 
program you normally use or have access to. 

These might include:

Microsoft Word

Google Docs

Apple Pages

OpenOffice

If you do not have access to any of these programs, please contact the instructor for help. 

The following projects will progressively introduce you to the powerful word processing tools 
at your disposal. 

NOTE:  If you need assistance on any project, please do not hesitate to contact me. If 
you would like me to review a particular assignment, I would be glad to do so.

Word Processing Projects		
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Project 6: 	 Word Processing
Learning Objectives:	 Open a new word processor document;  typing skills.			 

Step 1:	 Using your preferred word processor of your choice, open a new, blank docu-
ment.

Step 2:	 Type!  Get used to typing on your computer. Practice using the delete/backspace 
key, the return key, etc. Spend a few minutes and type several lines of text, not-
ing how you don't need to press the return key at the right margin.

Step 3:	 Save a copy to upload to Canavas at the end of the course. 

Benefits of Touch Typing:

Speed - This is going to be the first and most obvious benefit of learning to touch type. A 
touch typist can easily reach typing speeds above 75-80 words per minute, while a non-
trained individual is around 10. This is increased by the fact that an accomplished touch typist 
doesn’t have to look at the keyboard. 

Accuracy - One of the most important things to learn no matter how hard you type is to type 
accurately. 

Time - If you increase your typing speed for example, from say 30 words per minute to 60, 
you have effectively halved the time it would take you to do the same amount of work. 

Decrease Fatigue - Typing is both psychologically and physically exhausting when done for 
long periods of time. Learning to touch type properly reduces mental and physical fatigue. 

Health - Overall, touch typing is better for your health. You’re not hunched over looking at the 
keys, and using all of your fingers actually reduces the risk for repetitive stress injuries (RSI). 

Productivity - By learning touch typing, you shall become more productive. 

Adapted from https://www.pitman-training.com/advice-hub/pitman-blog/why-is-it-important-to-touch-type
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Project 7:	 Word Processing
Learning Objectives:	 Selecting text; moving text; using cut, copy and paste

Setup:	 As you did in Project 6 and will do for the remaining word processing projects: 

	 Open a new blank word processing document. Type in several lines of text.

Step a:	 Move the mouse cursor so the point touches a word, as illustrated in the graphic 
at the bottom of this page. Double click to select the word. 

Step b:	 From the EDIT menu, choose CUT. You will note that the selected word is gone, 
having been transferred to the computer's clipboard. The blinking text cursor 
remains in-between the two words which bracketed the selected word. 

Step c:	 Without moving your cursor, from the EDIT menu, choose PASTE. Note the cut 
word reappears right where it was. 

	 Now that you have seen how cut and paste works, lets edit a sentence.

Step 1:	 Repeat Step 'a' above to select a word.

Step 2:	 From the EDIT menu, choose CUT. 

Step 3:	 Using the mouse, click in-between two other words in your text. You will see the 
blinking text cursor jump to its new position.

Step 4:	 From the EDIT menu, choose PASTE. You will see the cut word appear in its 
new position. You may need to press the spacebar to separate it from the word 
which follows it.

Step 5:	 Practice CUTing and PASTEing. Type a series of words and, using cut and 
paste, reorder the words. Once you get comfortable with the process, editing 
is so much easier!

Step 6:	 Save a copy of both the original and the CUT and PASTE text to upload to 
Canavas at the end of the course.
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Project 8:	 Word Processing
Learning Objectives:	 Using the font, size and style menus

Setup:	 Open a new word processor document, type in any paragraph of text.

Step 1:	 Move the mouse so the point touches the beginning of one of the sentences. 
Holding down the (left) mouse button, drag the mouse until the cursor is at the 
end of the sentence. As you drag the mouse, the selection will spread over the 
text. Let go of the mouse button. If you are not happy with the selection, move 
the mouse to a blank area of the document and click. This will deselect the text, 
allowing you to try again.

Step 2:	 From the FONT menu, choose a new, significantly different font.  As you look at 
the menu, note that the currently used font will have a check mark by it. (Choose 
another and you will see the selected text change to the new font.) 

Step 3:	 From the SIZE menu, select a size significantly different than the original for a 
portion of your paragraph. As you look at the menu, note that the currently used 
size will have a check mark by it. (Choose another and you will see the selected 
text change to the new size.)

Step 4:	 From the STYLE menu / buttons, choose the style BOLD. As you look at the 
menu, note that the currently used style will have a check mark by it. (Choose 
another and you will see the selected text change to the new style.)

Step 5:	 Save a copy to upload to Canavas at the end of the course.  
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Project 9:	 Word Processing
Learning Objectives:	 Setting the margins

Setup:	 Open a new word processor document, type in a brief paragraph of text.

Step 1:	 Note that the default paper size is 8 1/2 x 11 inches, the size of a standard sheet 
of paper. The default for most word processor documents is a 1 inch margin on 
all four sides, reducing the working area to 6 1/2 x 9 inches. 

Step 2:	 Microsoft Word - 	 From the FORMAT menu, choose DOCUMENT...
	 Google Docs -	 From the FILE menu, choose Page Setup. . .
	 Apple Pages -  	 Click the DOCUMENT icon at the top right

You only have to type in the number, not "inches". For a 
half-inch margin, type .5 and for a quarter-inch margin 
you would type .25. You can set the margins to 0, but 
most printers can not print to the edge of the paper. 

1     =  1 inch margin

.75  =  3/4 inch margin

.5   =  1/2 inch margin

.25  =  1/4 inch margin

Step 3:	 You will see the four margins 
and their settings: top, bottom, 
left and right. All four indicate 1 
in. Clicking in the 'TOP' text box 
selects that setting. Using the 
TAB key will move the cursor 
from setting to setting. Change 
the LEFT margin to 2.

Step 4:	 Click the OK button or press 
ENTER on the keyboard. You 
will now see your document 
again, with a 2 inch left margin, 
perfect for binders!

Step 5	 Practice! Try changing  the mar-
gins in different combinations 
and see what happens. 

Step 6:	 Save a copy of your para-
graph with at least 2 of the 
margins changed (from the 
default) to upload to Canavas 
at the end of the course. 
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Project 10:	 Word Processing

Using tabs is a huge time saver if you are typing columns 
or forms. To the right you see four triangles which represent 
the four kinds of tabs. There are built-in tabs every 1/2 inch 
of a new word processor document

You are going to copy the text as shown at the 
right, using the preset tabs. Tap TAB until the 
cursor is at the 2" mark and type the word, 'one'. 
Press TAB 2 times to move the text cursor to 
3 inches and type 'two'. Press TAB 2 times to 
move the text cursor to 4 inches and type 'three'. 
Press return to move to the next line. Repeat the 
process until you have typed nine numbers.

You are now going to set the tabs and make it 
easier to repeat step 1. From the EDIT menu, 
choose SELECT ALL. From the EDIT menu, 
choose CLEAR. This will erase the text from 
your screen.

Double (or control) click the 2" mark on the ruler 
and place a LEFT TAB. This will replace the pre-
set tabs with your own. Place two more left tabs 
on the 3" and 4" ruler marks.

Repeat Step 1. You will note that it only takes a 
single press of the TAB key to move from 2" to 3" 
to 4". Your work is cut in half!

Practice! Try choosing SELECT ALL from the 
EDIT menu and sliding the tabs along the ruler. 
The columns of text will move as well.

Save a copy to upload to Canavas at the end 
of the course. 

Step 1:

Step 2:

Step 3:

Step 4:

Step 5:

Step 6:

Setup: Open a new word processor document.
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Project 11:	 Word Processing
Learning Objectives:	 Using what you have learned.

Step 1:	 Here you will combine many of the word processing skills you have learned. Us-
ing the letter below as a template (Brownie Points awarded for creating your own 
content), create a document which uses: different fonts, sizes and styles of text; 
different justifications; tabs; indents. Impress me!

Step 2:	 Save a copy to upload to Canavas at the end of the course. 

								              	           August 17, 2022 
Dear Parent:

    We are rapidly approaching the end of our second semester!  Expect to receive 
report cards for your child during parent conferences, which are scheduled to begin 
next month.  This letter outlines the 'Reading Time' goals for which we have been 
striving since school began in late August.

We have focused on the following topics:

	  	 Reading for main idea
	  	 Reading for details
	  	 Writing for specific audiences
	  	 Writing to provide necessary details
	  	 Study skills - creating a positive positive environment for learning

    I trust that by your receiving this information in advance we can spend our time 
together during our conference session discussing goals for the next marking period.  

    Please bring with you to the conference any questions you might have.  I appreciate 
you setting aside this time to discuss and share ways we can support one another! 

Sincerely,

Mrs. Rebecca Young

5th Grade Teacher
Youngstown Elementary
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Spreadsheets

Glossary
Cell: The intersection of a row and a column on a spreadsheet in which data can be entered. 
Cells are designated by their column letter and row number, i.e. B4.

Column: The vertical divisions of a spreadsheet that intersect the horizontal divisions (rows) 
to form cells in which data can be entered. Columns are labeled alphabetically (A, B, C ...).

Formula: A type of information that can be entered into a spreadsheet cell. It is a mathemati-
cal equation consisting of numbers, other cell designators, and symbols for mathematical 
operations. The result of the formula is displayed in the cell that holds the formula.

Label: A type of data that can be entered into a spreadsheet cell. It consists of words that 
usually label a column or row of numbers.

Row: The horizontal divisions of a spreadsheet that intersect the vertical divisions (columns) 
to form cells in which data can be entered. Rows are labeled numerically (1, 2, 3, 4 ...).

Select	: To mark where the next action will take place. Before a command is chosen, items 
are selected by clicking or dragging the cursor (or I-beam) across them.

Spreadsheet: An applications program, used in financial forecasting, that can quickly handle 
calculations and perform evaluation.

Value: One type of data that can be entered into a spreadsheet cell. It consists of numbers 
(as opposed to words) that can be added, subtracted, etc.

A spreadsheet is a very powerful computer tool. Making use of the mathematical capabilities 
of a computer, spreadsheets can greatly automate and speed an otherwise dreary endeavor. 
With a spreadsheet, working with numbers can be exciting and (with charts) visually interest-
ing. Think of a spreadsheet as a computerized checkbook; you keep a running balance by 
subtracting every check written from the previous total. To do this, you write the numbers in 
little squares, called Cells based on the information already written in other little squares. 
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Spreadsheet Basics 
Spreadsheets appear as a series or grid of columns and rows. Each column in a spreadsheet 
is labeled with a letter at the top. Each row is labeled with a number at the left. The intersec-
tion of a row and column is called a cell. Each cell has a unique address, which consists of 
the column letter and row number (for example, B2)

•You enter a cell's contents using the entry bar at the top of the spreadsheet. You can enter 
text, numbers, or formulas into cells. 

•Formulas are not actual values like text or numbers. Instead, formulas are a set of instructions 
that spreadsheets follow to produce a value for a cell. You see a cell's formula in the entry bar. 

•The formula's result appears as the actual value in the spreadsheet cell. The spreadsheet 
always has one current (active) cell, and that cell has a heavy, thicker border. The contents 
of the current cell, if any, appear in the entry bar.

Entering Data Into Cells

You can enter data into a cell at any time.
To enter data into a cell:

1.	 Select (click in) a cell in the spreadsheet.
	 This cell becomes the current, active cell.

2.	 Type the data in the entry bar. To enter negative numbers: Type a minus sign (hyphen) 
and then type the number (for example, -56).

	
3.	 Confirm the entry by pressing either the Enter key, the Return Key, clicking in another cell 

or clicking the checkmark icon.
 

Active Cell Indicator
Functions Entry Bar 

Chart

AcceptCancel

Rows

Columns
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Making Calculations 

The key point to remember is you do mathematical operations on cell addresses and not on 
the numbers themselves. That's a concept a bit alien to beginning computer users, however. 
To understand this better, look at the figure below. Notice that we have two values entered 
here, 823 in cell A1 and 84 in cell A2. 

The two numbers are now ready to be added. 
The goal is to add the numbers together and 
put the sum in cell A3. We could go to cell A3 
and type, "=823+84" to get the answer, but that 
would simply be using the spreadsheet as an 
adding machine. To get accustomed to using 
formulas, we instead utilize the cell addresses 
(in cell A3, we would type in "=A1+A2"). As a 
result, in the future, the sum in cell A3 would 
be updated any time we changed the values in 
either or both cell(s) A1 or A2. 

1.	 Move the cursor to cell A3 with the arrow keys. Or, move the mouse cursor over cell A3 
and click with the left mouse button. Now, lets create a formula!

2.	 Start by typing an 'equal' sign "=". You will note it appears in the entry bar, not the cell.

3.	 Move the cursor to cell A1 with the arrow keys or the mouse. Click the mouse button. 
Notice that the text "A1" appears after the "=" in the entry bar.

4. Next, type a plus sign '+' after "A1"

4.	 Move the cursor to cell A2. Click the mouse button. Note that the text "+ A2" appears after 
the "= A1+" in the entry bar.

5.	 Press ENTER. The sum now appears in cell A3, the formula (=A1+A2) in the editing line, 
and the cursor on cell A3, as well. 

You could also have typed in any arithmetical operator if you'd rather have subtracted, mul-
tiplied or divided.

In Apple Numbers, the + sign is automatically 
added to the formula.
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*
Numbers versus Text Labels 

Spreadsheets treat numbers and text labels differently. In a spreadsheet, you can use numbers 
in calculations. Text labels (i.e. "Reading Scores") always have a numerical value of "zero," 
even when they look like a number. 

Creating Charts From Your Spreadsheet

You can transform the data in a spreadsheet into a chart (charts are also sometimes called 
graphs). A chart can visually reveal trends or relationships that aren't readily apparent by 
looking at rows and columns of numbers. You can create a chart from part or all of the data 
in a spreadsheet. 

To make a chart, Select (highlight) the cells that you want to chart, including the Title and 
Names (seen below, down row 1 and across column C) and the numbers that make up the data. 

Microsoft Excel 	 From the INSERT menu or Tab, choose CHART
Google Sheets 	 From the INSERT menu or       icon, choose INSERT CHART
Apple Numbers	 Click the          icon 

You can create a variety of charts from the same data. Each chart type offers a wide range 
of options for presenting data. 

+ 	 add			  -  	 subtract

   	 multiply		  / 	 divide
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Project 12:	 Simple Spreadsheet
Learning Objectives:	 Open a spreadsheet document and create a simple spreadsheet

Setup:	 Open a new spreadsheet document

Step 1:	 Click on cell A1, type in the number 23
	 Click on cell A2, type in the number 47
 
Step 2:	 Click cell A3, type an equal sign (=) to begin creating a formula.

Step 3:	 Click on cell A1. Note that the number contained in cell A1 is placed 
after the equal sign in the enty bar (i.e. = 23)

Step 4:	 Type in a plus sign (+) and then click on cell A2. Your fomula is now 
complete: = A1 + A2

Step 4:	 Press the Return key and you will see the solution to the formula 
(70) in cell A3

Step 5:	 Practice! Try other numbers, longer lists of numbers and different types of calcu-
lations. When you get a spreadsheet you like (with at least 5 numbers), save a 
copy to upload to Canavas at the end of the course. 

              Google Sheets	                   Microsoft Excel			   Apple Numbers

For very long lists of numbers, there is a Sum func-
tion which will automatically add a selected range of 
cells. Highlight a column of numbers plus one empty 
cell below and then select the Sum function.
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Formulas and Functions

Functions consist of the function name 
followed by one or more arguments en-
closed in parentheses. Arguments are the 
values you supply to a function so that it 
can perform a calculation.

Microsoft Excel	 467 Functions
Google Sheets	 431 Functions
Apple Numbers	 250+  functions

The formula in cell A3 (from the previous page) can be changed to any number of mathematical 
formulas. Spreadsheets can use simple functions or far more complex calculations, including 
algebraic, trigonometric and statistical computations.

In the Microsoft Excel spreadsheet, clicking the 
Function button allows you to choose a formula from 
an annotated   menu of types.

Google Sheets divides functions into categories. 
Selecting a function will display its properties.



Page 87 Introduction to Computers for Teachers

Project 13:	 Class Survey Hair Color
Learning Objectives: 	 Create a spreadsheet with a pie chart. 

Sometimes no formulas are needed in a spreadsheet. Here, a group of students was surveyed 
and their hair color recorded in a simple spreadsheet. The information was then translated 
into pie charts to present the information visually.

Setup:	 Open a new spreadsheet document

Step 1:	 In cell A1, type Hair Color.
 
	 This will be your title. Press Enter (on the numeric keypad) Cell A2 should become 

the active cell. If it is not, click in cell A2 to select it.

Step 2:	 Type in several different hair colors, one in each cell, as shown below. Pressing 
Return will select the next cell down. Feel free to use the examples presented in 
the sample below, if you wish, or create your own.

Step 3:	 Click in cell B2 to select it. Type in numbers of students with the hair color indicated 
in the same row. 

Step 4:	 Using the mouse, drag to select cells A1 to B5 of your spreadsheet.
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Step 5:	 Click the Make Chart button on the Button Bar or choose Make Chart from the Op-
tions menu. When the Chart Option screen appears, click the Pie icon, then OK.

Making the Pie Chart

Step 7:	 Save a copy to upload to Canavas at the end of the course. 

A simple pie chart will appear in the spreadsheet. You can adjust the look and information 
within the graph by choosing several options:

Microsoft Excel Select an item from the CHART DESIGN TAB

Google Sheets Double-click the chart to open the CHART EDITOR

Apple Numbers Click the chart then select an item from the Format menu

Step 6:	 Adjust the settings on the pie chart so that the percentage of each type of hair color 
is displayed in the relevant pie slice.

Numbers SheetsExcel
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Formatting

Most of the time using the pre-defined width and height of spreadsheet cells is fine. There 
are times when you may want to change these settings. If you are doing a spreadsheet in a 
72 point font size, the letters will be too tall to fit into a cell. 

To adjust the width of a column of cells, click (or click-drag) to select one or more columns. 
Place the cursor on one of the lines dividing two columns and drag left or right to increase or 
decrease the width of the relevant columns.

You can adjust the height of cells in a similar fashion - select the row(s) of cells you want to 
change, then drag the dividing line between two cells up or down to increase or decrease 
their height.

Generally, you can use the same formatting options in a spreadsheet as you can a word 
processor - font, size, style and color can be changed for a single cell or any sized group of 
cells.

Numbers

Excel

Sheets
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Computer Graphics 
Computer graphics are fun! Few other uses of the computer allow you to expand your ability 
and expression like computer graphics. The best part is... you don't have to be an artist to 
create them - learn to let the computer do the work for you!

There are two basic ways that a computer displays graphic information on a screen: bitmap 
and object. These two types are represented by two general kinds of computer graphics 
programs: PAINT (bitmap) programs and DRAW (object) programs. 

Basically, a bitmap is an array of pixels. A bitmap can be of various bit depth and resolution. 
Each pixel takes up one space on the monitor; there can not be two pixels in the same location. 
All the pixels are on the same layer - that is, no pixel can be in front of or behind another pixel. 

There are hybrid programs, such as Adobe's Photoshop and Corel's Painter, which have 
elements of both paint and draw within the same application. For the purpose of this introductory 
course I will introduce you to a few of the tools common to all programs which create only 
PAINT (bitmap) graphics.

There are literally hundreds of graphics programs on the market. All Paint programs, whether 
on a Macintosh, Windows computer or cloud-based, share a common set of tools; pencil, 
paintbrush, eraser, spray can, simple geometric shapes. Paint programs may be quite simple 
or very sophisticated. For now, let's keep it simple!

The following pages illustrate some of the commonly found tools used in PAINT programs. 

With all the tools, a three step process is used: 

1) Click once on a tool to select it.
2) Move the cursor to the part of the document where you want to use the tool.
3) Click or drag the mouse to use the tool. 
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Graphics Glossary 
Anti-aliased: Anti aliasing an edge of an element or a mask is to give it a slightly soft edge 
that makes it appear smoother. It is similar to feathering by one or two pixels. 

Bitmap: Another term for a line-art scan file or scanner setting. Refers to the pattern (map) 
of bits that are either black or white. 

Bitmapped Image: A bitmapped image is a computer file representing a line-art image that 
was scanned with a scanner. 

Clip Art: Electronic illustrations that can be inserted into a document.

Clipboard: An imaginary place where images that are 'cut' or 'copied' go. The clipboard can be 
'loaded' with an image, then that image can be pasted (multiple times) back onto a document.

Cropping: The act of discarding unwanted detail around the edge of a picture. Cropping in 
this way permanently discards the detail from the file and reduces file size.

Draw: A category of graphics program defined by its use of elements (entire images or shapes) 
to create images on the computer screen.

Export: Term used in some illustration programs that allows the drawing to be saved to the 
hard disk in a commonly readable format allowing the drawings to be placed into a page layout. 

Fill: A menu command that allows a path to be filled with a color or tint. 

Graduated Fill: A command within illustration software that allows elements within the 
illustration to be filled with a smooth transition between two colors. 

Gray scale: A term for a black & white photographic image or a scanner setting. Refers to the 
range of 256 grey tones that make up the image.  

JPEG: Joint Photographic Experts Group Compression. A method to save storage space by 
compressing files. Most of the images you see on the internet are JPEG images files.

Paint: A category of graphics program defined by its use of individual pixel elements to create 
images on the computer screen.

Pixel: The smallest building block within a scanned line-art or photographic image. A pixel 
is the small square picture element that is filled with a color, or black or white. Resolution is 
measured in pixels per inch (PPI.) 

Resolution: The sharpness and clarity of an image on a computer screen or a paper print-
out.

Screen Capture: Refers to the act of copying what is currently displayed on a screen to a 
file or printer.

Video Card: Part of the internal circuitry of a computer which governs the it's output to a 
monitor. Different cards vary in speed and resolution.



Page 92 Introduction to Computers for Teachers

Painting Tools
For the purposes of this introductory course, you will be using a simple, free, online computer 
graphics program called jspaint. The tools are very retro - harkening back to the old Windows 
Paint program. If you look closely at the tool palettes illustrated below, you will see some tools 
common to all the programs, from the simple online jspaint to the pricey Adobe Photoshop.

Windows Paint sketch.io

Adobe Photoshop

sumopaint.com
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Painting Tools

Below is the tool palette for JSPaint. All tools are (hopefully) labeled by a representative icon. 
Operation if straight-forward click on a tool and use it by click-dragging on the workspace. 

The palette features 'tool tips' - hovering the mouse over a tool will reveal 
its label. A very handy feature most programs share.

SELECTION RECTANGLE

FILL WITH COLOR

MAGNIFIER

(PAINT) BRUSH

TEXT

CURVE

POLYGON

ROUNDED RECTANGLE

 FREE-FORM SELECT

ERASER

COLOR PICKER

PENCIL

AIRBRUSH

LINE

RECTANGLE

ELLIPSE

LINE

LINE AND FILL

FILL

COLOR PALETTE

JSPaint also has Save and Open 
functions - both of which you will use 
in the upcoming projects.
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Brush

To use the Brush:

1.	 Select the Paint Brush from the tool panel.

2.	 Click once to paint a spot. Click and drag to paint a line.

To change the brush shape or size:

. Select a shape from the Brush Shape palette.

Pencil

To use the Pencil:

1.	 Select the Pencil from the tool panel if not already selected (it is usually selected as the 
default, set to black).

2.	 Select a color (if other than black is desired) from the Color Palette.

3.	 Click once to paint a single dot or drag the Pencil to draw a line.

Eraser 
To use the Eraser:

1.	 Select the Eraser from the tool panel.

2.	 Click to erase only what is underneath the Eraser, or click and drag the 
Eraser to erase large areas.
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Selection Rectangle
To use the Selection Rectangle:

1.	 Select the Selection Rectangle Tool from the tool panel. The pointer will look like a cross-
hair      when you move it in to the work space.

2.	 Position the crosshair at a corner (usually the upper left-hand corner) of the image you want 
to select. With the mouse still depressed, drag down and to the right to define a rectangle 
which encompasses the image you wish to select.

When you release the mouse button you will know the selection is com-
plete as it will now be surrounded by animated dotted lines (giving the 
appearance of 'marching ants') which will remain around the selection 
until the mouse is clicked somewhere other than inside the selection.

Moving the cursor within the dotted lines will change the cursor to an arrow icon. Once this 
cursor is visible, you can move it, copy it, and rotate it.

Airbrush 

Use the Spray Can to “spray paint” the fill color, pattern, wallpaper, or gradient.

To use the Airbrush:

1. 	Select the spray can icon in the Tools panel.

2. 	Choose a fill color or other attribute from the Tools or Accents window.

3. 	Hold down the mouse button to spray continuously or drag to spray an area.

Shape Tools
Each shape tool comes in two types, Filled and Empty. The empty shape tool 
produces a certain shape, as defined by its outside lines. The interior of the 
shape is transparent. By creating several overlapping shapes, you can see 
the transparent nature of each shape, as all lines are visible.

Filled shapes, on the other hand, are solid, as the interior of the shape is 
opaque. The color of the fill is determined by using the fill color palette and 
/ or the pattern palette.

The shapes are filled via the Color Palette. There are two parts to a filled 
shape, the outside (called the Pen) and the interior, called the Fill.
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Cut, Copy and Paste

As with most programs, there is an Edit menu which 
lists several functions which will effect all or part of a 
document. In the case of a Paint program, the effect 
is limited to part of the painting which are selected 
with the lasso.

To copy (duplicate) an image:

1.	 Select what you want to copy with the Selection 
Rectangle.

2.	 Choose Copy from the Edit menu. 
3.	 Choose Paste from the Edit menu. A the copy of the selected item will appear on 

screen.
4.	 Mover the cursor over the new item - the cursor will change

Select

Copy
Paste
Move

Cutting an image will remove it from the screen, but you can still Paste it (multiple times if 
needed) back into your painting.

Clear Selection (from the Edit menu) an image will erase it from the painting. To erase the 
entire screen, choose Select All, then choose Clear Selection.

Other Tools

Jspaint has a few other tools which are not used for the projects addressed in this course. You 
are welcome to experiment with them, as well as explore ther computer graphics programs.
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The following  projects will introduce you to the use of the most basic computer 
graphics tools. It is beyond the breadth and scope of this course to make you a 
master of computer graphics - I just want you to get a 'taste' of where you can 'go' 
with computer graphics and determine whether or not they could ultimately enhance 
delivery of instruction. Keep in mind this is the simplest, most basic computer graph-
ics program. If you are comfortable using another program to complete the projects, 
you are welcome to do so.

My goal is to whet your appetite, increase your confidence, and get you thinking about ways in 
which you can integrate graphics across your curriculum, engaging and motivating students. 

Once you've mastered a technique, try it in your own paintings; perhaps an illustration for a 
class paper or an overhead presentation. Keep in mind that I chose this particular program 
because it has the basic tools I wanted to address and is accessible to all users. There are 
many, many programs which are much more sophisticated than jspaint, including a good 
number of free ones. 

Paint Projects		
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Project 14:	 Painting
Learning Objectives:	 Familiarize yourself with painting tools.

Setup:	 Go to 	www.jspaint.app The link is on the course website; jspaint is a very simple 
graphics program, patterned after Windows Paint. The tools are rudimentary, 
but share DNA with all other modern computer graphics programs.

Step 1:	 Play! Try out the different tools. Keep in mind that you are experimenting, so 
there is no such thing as a mistake! But if you are not satisfied with your results, 
you can go to the FILE menu and choose NEW - providing you with a "clean 
slate" on which to work. Spend as much time as you like doodling and tinkering 
around with the tools. Remember, you are not only getting used to the paint 
program and its tools, but handling the mouse (or using the trackpad) as well. 
Using a variety of tools and techniques, as below, tinker around and show me 
what you've got! Doodle are good - I prefer that you don't just 'scribble'.

Step 2:	 From the File menu, Save a copy to upload to Canavas at the end of the 
course. 
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Project 15:	 Painting 
Learning Objectives:	 Mouse control
				    Selecting the appropriate tool
				    Using the fewest steps possible
				    Transparent shapes & objects

Generally, the larger image you draw, the easier it is to control. 
Your box should be at least 2" wide. Anything smaller and 
you will be forced to draw any details in a very small area.

Setup:	 Go to www.jspaint.app  

Step 1:	 Click on the SQUARE (not the FILLED SQUARE) tool in the tool 
palette

Step 2:	 Position the cursor in the middle of the screen.

Step 3:	 Press and hold the mouse button down. Move the cursor (mouse)
	 down and right to define a square. Let up on the mouse button.

Step 4:	 Position the cursor in the middle of the square you just drew.

Step 5:	 Press and hold the mouse button down. Slowly move the mouse
	 down and right to define a second square. It should be the same 
	 size and shape as the first square you drew. Let up on the mouse 

button.

Step 6:	 Click on the LINE tool in the tool palette.

Step 7:	 Move the cursor to the upper left-hand corner of the first square. 
	 Hold the mouse button down to begin painting a line. Move the 
	 mouse (thus, the line) to the upper, left-hand corner of the 
	 second square, connecting the two.

Step 8:	 Following the steps in 7, connect the other three corners of the 
	 first square with their counterparts in the second square.

Step 9:	 From the File menu, Save a copy to upload to Canavas at the 
end of the course. 

HINT: Make the screen bigger for better control:  Hold the Command key and 
tap the plus sign (+) on a Mac. Hold the Control key and tap the plus sign (+) 
on a Windows computer.
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Setup:	 Go to www.jspaint.app. 

Step 1:	 Select the CIRCLE tool in the tool palette. Make sure 
the LINE rectangle is selected at the bottom of the 
palette (see below).

Step 2:	 Position the cursor on the mid-left hand corner of the 
screen. Remember you can always UNDO and action.

Step 3:	 Press and hold the mouse button down. Slowly 	
move the mouse down and right to define an oval

	 (at least 3"- 4" long). Let up on the mouse button.

Step 4:	 Still using the circle tool, draw a small circle toward 
the left-hand side of the oval. This will be the eye.

Step 5:	 Select the CIRCLE TOOL then click the  FILL rectangle. 
The default color is black.

Step 6:	 Draw an even smaller circle inside the eye circle. This 
will be the pupil.

Step 7:	 Select the PENCIL tool from the tool palette.

Step 8:	 With the pencil tool, you are in freehand painting mode. 
Position the cursor near the top-middle part of the body 
oval. While holding the mouse button down, paint the 
dorsal fin. 	

Project 16:	 Painting
Learning Objectives:	 Using the shape tools
				    Using the paintbrush
				    Using patterns
				    Freehand drawing

LINE

LINE AND FILL

FILL
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Step 9:	 Still using the pencil tool, paint in the tail and side 
fins.

Step 10:	 Click on the ERASER tool in the tool palette.

Step 11:	 Erase the line segments where the tail fin and side 
fin overlap the body.

Step 12:	 Click the AIRBRUSH tool. There are three sizes of 
spray patterns. I would suggest the largest.

Step 13:	 Click on the light grey color from the color palette.

Step 14:	 Spray on some shading - just enough to give the 
impression of texture and shadow. 

Step 15:	 From the File menu, Save a copy to upload to Canavas at the end of the 
course. 
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Project 17:	 Import and Edit
Learning Objectives:   Importing clip art, using the pencil tool to embellish an image

It is possible to modify artwork to 'make it your own'. In this 
assignment you will import some clip art and add detail to 
it using the pencil tool. 

Clip art is available from many sources and can be down-
loaded from the Internet or transferred from a camera. 
Here you will be using an image that is located in the 'TEC 
923 Resource' folder you downloaded earlier.

Step 1:	 Go to www.jspaint.app. Chose 
OPEN from the FILE menu. A 
window will open enabling you to 
search your computer to locate the  
TEC 923 Resources folder. 

 
Step 2:	 Once you have located it, open the folder 

and click the 'girl' icon, then click OPEN.

Step 3:	 Using the pencil, eraser and other tools,  
modify the image by adding a background 
or other elements. Remember you can 
UNDO an action or even reload the image 
to start over.

Step 4:	 Save a copy to upload to Canavas at the 
end of the course. 

Note:	 On a Windows computer, the file 
should appear in the DOWN-
LOADS folder, and will need to be 
transferred to your portfolio folder. 
On a Mac, the file will be saved to 
the Downloads folder or the Desk-
top, and will need to be transferred 
to your portfolio folder. 

If you wish to use another graphics program to com-
plete this assignment, you are welcome to do so.
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Introduction to the Internet
A network is a collection of computers that are wired together to allow people on one com-
puter to share data, programs or resources on another computer. The computers at your 
school most likely are on a network. If they are, the Macintosh, PC or Chromebook on your 
desk connects to the  network via an Ethernet cable (a high speed data connection) or you 
can use a modem to connect to the network via a phone line.

The Internet, or World Wide Web, is a collection of thousands of networks around the world. 
A single computer or an entire network connects to an Internet Service Provider (ISP) net-
work, which in turn connects to the Internet backbone - the main cables capable of carrying 
thousands of internet activities at one time.

The Internet was created in the 1970’s originally for the military. It was created so the military 
could access and transfer data quickly and could function even if one portion of the network 
was attacked. Academic institutions used the same system to create their own 'network of 
networks' in conjunction with the National Science Foundation. Businesses then wanted ac-
cess to this vast area of information, which lead to one integrated Internet.

The Internet is not owned by any one person or organization. Each individual network which 
makes up the internet is controlled by those individual people or organizations. There are, 
however, organizations that oversee and standardize what happens on the Internet and as-
sign IP addresses and domain names, such as the National Science Foundation, the Internet 
Engineering Task Force, ICANN, InterNIC and the Internet Architecture Board.
 
Internet-connected computers each have a unique numerical address, called an Internet Pro-
tocol (IP) number which is used to locate that computer on the Internet. These addresses are 
represented by four number groupings – such as 129.170.20.10 However, it is much easier 
for people to remember names - not long strings of numbers. 

For example, the IP number for Google.com is 216.58.194.174
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Therefore, an intermediary system was developed which translates names that people un-
derstand into numbers that computers understand. This system is called the Domain Name 
System (DNS). A computer name in the DNS can contain up to four parts: machine name, 
sub-domain, domain, type of organization. These parts help people identify the specific com-
puter to which they want to connect. For example: www.discovery.com.

The DNS system stores the names of each computer on their network in a table, with the cor-
responding IP number for each computer. So, when you type in a computer’s name, the DNS 
table provides the IP number for that computer, which your computer then uses to make the 
connection. You can make a connection using the computer’s name or the IP number.

The internet’s popularity has increased because of all the different things you can do: e-mail, 
access information, transfer files, log on to remote machines, participate in scholarly discus-
sions, read and debate issues, etc. 

From an internet address, you can tell what type of organization controls the website. Com-
mon organization types are:

*	 .com	 - Commercial entities
*	 .net	 - Organizations directly involved in Internet operations, such as ISPs
*	 .org	 - Miscellaneous organizations, including non-profit groups
*	 .edu	 - Four-year, accredited colleges and universities 
*	 .gov	 - US Federal Government entities 
*	 .mil	 - US military 

When trying to connect to another computer, there can be no spaces in the name, and no 
typos. A computer doesn’t know that “discovry.com” is supposed to be “discovery.com”.

Once you know the name or IP number of the computer to which you want to connect, you 
have to decide the protocol you want to use to connect to that computer - in what language 
you want your computer to talk to the other computer. You have a variety of options. HTTP 
(Hyper Text Transport Protocol) is by far the most common.

URL stands for Uniform Resource Locator. The first part of the string specifies the protocol 
(computer language) one computer uses  to talk to another computer. The name of the com-
puter to be communicated with is then specified. You can further specify a particular folder, 
and/or file on the remote computer that you want to view, by entering it after the protocol and 
computer name.
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The World Wide Web (WWW) has become synony-
mous with “Internet”. However, it is actually a graphical 
interface to the resources available on the Internet. This 
interface is called HyperText Transfer Protocol (HTTP). 
Common applications that use this interface are web 
browsers such as Chrome, Internet Explorer, Firefox, 
and Safari. Web Browsers can also use other types of 
protocols.

HTTP allows you to link a document on one computer 
to a document on another computer, no matter where in 
the world those two computers are located. You could 
read one document, click a word and jump to a second 
document, click on another word and jump to a third 
document, and so on. Using hypertext, you can move 
from one computer to another, located all over the world, 
using nothing but the links in those documents. 

These documents must be created using Hypertext 
Markup Language (HTML) in order to include these links. 
The HTML code for these documents contain URLs, 
which point you to other documents at other locations. 
There are many different ways to locate information on 
the Internet. There are web sites to help you find general 
information, and other sites which help you find a par-
ticular type of information - such as an e-mail address. 

This is the HTML programming code for the White 
House web pages seen above. It is this text your 
computer 'sees' when you connect to a  web site, 
which is then interpreted by the web browser into a 
familiar looking page.

Search Engines are akin to your phone book yellow pages. They gather information from the 
millions of web sites around the world and build a cross-indexed register of those sites. You 
can then search that catalog, using key words and phrases. A broad search, such as 'history' 
will yield a large number of results (see below).

Google Chrome

Firefox
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Obviously, almost 13 billion web pages would take several lifetimes to read, so it is best to 
use multiple search words to narrow a search.

The search above has been narrowed to 'history ancient china' and Google has been asked 
(site:gov) to only show sites with the .gov suffix (official government web sites). Most search 
engines have advanced search options, which help you narrow a search in different ways.

	
						    
	

Downloading Software

If you are interested in downloading software from the internet, go to the web site of the com-
pany that developed the program (such as www.k12software.com). They usually have links 
to their distributors' sites, or allow you to purchase the software directly from them. In many 
instances you can download a demonstration copy of the program. Many companies put 
updates and 'fixes' to their programs on their web sites. If you have their program installed, 
you can download any product updates directly from the Internet. Additionally, there are web 
sites where you can download free software, “shareware” or trial versions of programs.  Two 
such sites are: http://www.download.com/   and  http://downloads.zdnet.com/

Learning More

The best way to learn is by using the Internet. To learn about it online at your own pace, go to 
www.learnmyway.com/get-started/internet where you’ll find an introduction to the history and 
content of the Internet and World Wide Web; a review of the necessary components you’ll 
need for connecting to the Internet; tips and instruction for communicating with other Internet 
users, using the Web to locate information, and observing proper etiquette.

Google can limit search results by date. To see the search options, click 
'Search Tools' after you do an initial search.
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Network Glossary 
Acceptable Use Policy or AUP - Common in school, rules governing how network/computers 
used, often restricting material publicly available; many AUPs ban transmission of offensive 
material. 
 
Adobe Acrobat Reader - A reader for graphic files (PDF-printer definition files).
 
ASCII Text - American Standard Code for Information Interchange (ASCII) - A text file in which 
each byte represents one character. ASCII files are sometimes called plain text files.

Attached file - A file that is embedded into an email message.

Bookmarks - An index of network addresses that the user frequently visits stored in the 
browser. 

Browsers - A term referring to a software application that allows you to visit different Inter-
net addresses and browse web pages. The most popular are Firefox and Microsoft Internet 
Explorer.

Bulletin board system (BBS) - An electronic message center that serves specific interest 
groups. They allow you to dial in with a modem.

Cable modem - An device linking a computer to the internet using service provided by a cable 
television provider. Thls bypasses the need for a phone modem, and the cable connection is 
always on. 

Social Network - Interactive online communication enabling typed conversations to occur in 
real-time so messages instantaneously relayed to all members.
 
Client - A computer system or process that requests a service of another computer system 
or process. A workstation requesting the contents of a file from a file server is a client of the 
file server. 

Cloud Storage: the generic name for placing files onto remote internet - accessible servers. 
Popular cloud storage services include Dropbox, iCloud, Google Cloud and OneDrive.

Cyberspace - The place where computer networking hardware, network software, and people 
using them converge.

DNS - Domain name server. Service used with TCP/IP hosts, housed on multiple servers. 
Maintains database for figuring out and finding (or resolving) host names and IP addresses 
on the Internet. 

Domain - Categorizes entities. .com=commercial; .gov=government; .edu=educational insti-
tution.

Download - Retrieving a file from another computer.

Electronic mail / E-mail - Method whereby computer users exchange messages with each 
other over a network. E-mail is probably the most widely-used communications tool on the 
Internet.
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Emoticon - A sideways face created by using special characters on the keyboard to express 
emotions without words, for example ;-)  or  :^(

Ethernet network and cards - A standard and probably the most popular connection type for 
Local Area Networks (LANs). 

Exchange - Electronic mail software by Microsoft. A Windows' software package.

Fiber optic cable - Thin, flexible, medium capable of conducting modulated light transmission. 
Compared with other transmission media, fiber-optic cable is capable of high data rates. 

Firewall - Controls unwarranted access to a network. In schools, firewalls are used to help 
filter out unwanted internet content.

Homepage - A web page that is typically the main source of information about a particular 
person, group, or concept. 

Hotspot - An area where wireless networking (WiFi) is available. 

HTML - The standard way to mark text documents for publishing on the World Wide Web. 

HTTP - Hypertext transfer protocol. Underlying protocol used by the WWW. When you enter 
an address in your browser, this sends an HTTP command to the Web server to 'get' the 
requested page.

Hub - A device connected to several computer and printer to a network.  

Hypertext - Text that includes links or shortcuts to other documents, allowing the reader to 
easily jump from one text to related texts, and consequentially from one idea to another, in a 
non-linear fashion. Coined by Ted Nelson in 1965.

Internet - Everyone's computers hooked together. Not an entity in itself. Always capitalized, 
the word Internet can also be referred to as the "Net."

Internet Service Provider (ISP) - Company who maintains a network that is linked to the 
Internet via a dedicated communication line, usually for a fee.

Intranet - Use of Internet technologies within a company via internal network sharing software 
and network equipment, fenced off from the outside Internet by "firewalls".

IP address - Internet Protocol address. Every resource has a unique numerical IP address, 
represented in dotted decimal notation. IP addresses are the closest thing the Internet has 
to phone numbers. 

Java - Programming language with features that make it well suited for use on the WWW.

LAN - "Local Area Network". Allows subscribers to share resources like files, printers, mo-
dems, etc.

Mailing list - A list of email addresses used to forward messages to groups of people. When 
you subscribe to a mailing list, you receive all mail sent to that list.
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Malware - software that is intended to damage or disable computers and computer systems. 
Usually download in inadvertently from a malicious website.

Modem - An early (1980s) device used to convert computer data for transmission and recep-
tion over telephone lines. 

Multimedia - A combination of sounds, animation and video on a computer workstation.

Netiquette - Informal rules of behavior that have evolved in Cyberspace, including the Internet 
and online services, i.e. using all capital letters is considered the equivalent of "YELLING".

Network - Group of computers connected by a series of servers, cables and network cards.

NIC Card - network interface card. Computer circuitry that allows it to use a high speed (Eth-
ernet) network. 

Protocol - The "language" spoken between computers to help them exchange information. 

Public domain - Any program that is not copyrighted. Public-domain software is free and can 
be used  without restrictions. Often used incorrectly to include freeware, free software that is 
copyrighted. 

Search engine - An internet site that allows for keyword searching online information. 

Server - A computer that provides resources, such as files and other information. Common 
Internet servers include file servers and name servers of Domain Name Service. 

Shareware - Copyrighted computer programs made available on a trial basis; use requires a 
fee (sometimes optional) to be paid  to the author of the program.

Spam - Unsolicited "junk" e-mail sent to large numbers of people to promote products or 
services.

TCP/IP - Transmission Control Protocol/Internet Protocol (TCP/IP). TCP/IP is the standard 
communications protocol required for Internet computers.
 
Upload - To transmit a file to another user or computer.

URL - Universal Resource Locator (URL). Unique address for an Internet resource which 
begins with letters that identify the resource type, followed by a colon and two slashes. 

Web based - Referring to a program (app) which is located remotely online, and requires a 
web browser to run.

Web page - A single online document containing information that can be accessed over the 
WWW.

WiFi - Wireless networking allowing a computer to access the internet without a cable.

Wireless Networking - The use of radio frequency signals to access networks without the 
need to be physically connected by cables.

World Wide Web - The "Web". Online documents, housed on Internet servers worldwide, 
"coded" in HTML. Requires a web browser to access.
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Project 18:	 Internet
Learning Objectives:	 Discussion of the educational uses of the internet.
To fill out and submit this form, please go to the Internet Survey link on the course website. I have copied the survey here merely for refer-
ence; you will submit your responses via the Course Website.  A copy of your completed form should be e-mailed to you after submitted.  A 
couple brief, succinct sentences should suffice - NOTE the last prompt asks for a more complete and thorough response.

How do you use the Internet as a classroom 
resource?

What precautions do / would you take to 
ensure your students are safely surfing the 
Internet? 

Does your school have an Internet Use Pol-
icy, also known as an AUP (Acceptable Use 
Policy)? If so, briefly outline the highlights. If 
not, do some research on the Internet and 
locate an example of an AUP or guidelines 
on developing one, then provide me with 
the URL (web address) in the space below. 
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Project 19:	 Internet Site
Learning Objectives:	 Searching the Internet; Discovering educational web sites
To fill out and submit this form, please go to the Internet Site Survey link on the course website. I have copied the survey here merely for 
reference; you will submit your responses via the Course Website.  A copy of your completed form should be e-mailed to you after submit-
ted.  A couple brief, succinct sentences should suffice

Search for or navigate to a favorite educational 
web site. Provide me with the URL in the space 
below.

How did you go about finding it (i.e. what brows-
er did you use)? What search criteria?

How do, or how would/could you use this web 
site in your classroom? 
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E-mail
E-mail is short for electronic mail. As with traditional mail, several pieces of information have 
to be included with each letter.

•Recipient    -   Who are you sending it to.
•Address      -    Their location, place to deliver the mail.
•Message    -    The contents of your letter.
•Sender       -     Your return name and address.

Most e-mail programs use the same analogy to create the 
message.  E-mails, like letters, can be complex or simplistic, 
plain or dressy.

When you send a message, the e-mail program sends it to 
a predefined mail server, which is a computer at your school 
district office or somewhere on the Internet. The message 
is then relayed to the recipient (if they are part of the same 
domain or organization) or to another mail server and finally 
to the recipient.

To create a new message, open your e-mail program or navigate to your e-mail web page. 
Click on 'New Mail', and a window will pop up.

The 'new mail' window contains text fields, where you type in the needed information.

'To:' - 	 this is the main address of the e-mail recipient.

'CC:' - 	 (optional) this is a carbon copy to send to another, with the original message.

'BCC:' - 	 a 'blind carbon copy' sent to another, with the original message. The 'blind' means 
the other recipient(s) will not know the message was sent to another party.

'Subject:' - a title or description of the message contents. It is important to fill in this area so the 
recipient can read the subject line before opening the e-mail. It is also important to 
check subject lines in delivered e-mail to prevent opening objectionable material.

Message Body: - Type or paste in the text of your e-mail message.
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GMail (Google)  - teacher@gmail.com

Microsoft Outlook - teacher@outlook.com

When you are satisfied with the message, click on 'Send' button or icon and the message will 
be sent if you are online, or will be stored in the 'Outbox' to be sent later when you go online.

It is also possible to send pictures, word proces-
sor files and other documents along with your 
e-mail. These files are called attachments.  

When you need to include an attachment, click on 
'Attach' button or icon from the menu bar and a 
window will open, allowing you to choose the file 
to you want to attach. Once you find the file you 
want to send, select it and click the 'Attach' button.

iCloud Mail (Apple) - teacher@icloud.com
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Project 20:	 E-mail
Learning Objectives:	 Using e-mail to communicate with a colleague.

If you would, please, send me an email! Using 'TEC 923 Email' as the subject line, send me 
a short note to check in and say hello. Send to my email address of: 

steveyoungfpuniv@aol.com
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Standards Correlation 
By designing and presenting lessons to your students using the understanding and experi-
ence you have gained from this course, you will fullfil several of ISTE's Technology Standards 
for Teachers. These have been defined as necessary tools for today’s teaching professional. 
This course does not address any specific states’ technology standards. It does, though, re-
inforce the ISTE educator standards. 

It is important you understand these standards and their perfor-
mance indicators, and can effectively apply them for practical use. 
For the purpose of this next assignment you will be asked to select 
any 5 projects presented in this course, then align them to the 
ISTE Educator Standards. You can find the standards detailed 
further at: www.iste.org/standards 

Once the web page is loaded, scroll down a bit and click on the 
'Learn More' link under the center 'Educators' column. 

You can also see the standards on the 'Resources' page of my  
website, www.steveyoungfpu.net

You will be asked to record your findings on the following page for three (3) assign-
ments. To assist you in completing this project, please refer to the sample below. 

Example:

To correlate Project #13, the "Hair Color Survey," to the ISTE educator standard, the digit 
'2' indicates that the project meets standard 2.  - "Leader." Next, the letter 'c' is the relevant 
Performance Indicator for Standard 2: "Model for colleagues the identification, exploration. . ." 

In explanation of the rationale underlying the selections, when you create spreadsheet charts 
for your classroom that you now have the skills to create, you have certainly met the goal of 
this standard and performance indicator! Congratulations! So, in putting it all together, this is 
how the completed Standards Correlation Chart would appear had you chosen Project #13 - 
"Class Survey Hair Color Chart" 

NOTE: You do not need to explain the rationale behind your selections; I did so only 
to illustrate the concept.

	
Standard					   

Performance Indicator 	

 
Name of Project: Hair Color Chart

C
Leader
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Project 21:	 Standards Correlation
To fill out and submit this form, please go to the Standards Correlation Chart link on the course website. I have copied the survey here 
merely for reference; you will submit your responses via the Course Website.  

Standard			 

Performance Indicator 	

Project 

Name of Project:

Narrative Response:

Does your district/school have a policy addressing 
technology integration in to the curriculum? If so, 
briefly describe it; if not, what sort of policy you would 
like to see implemented.

Standard			 

Performance Indicator 	

Project 

Name of Project:

Standard			 

Performance Indicator 	

Project 

Name of Project:
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Project 22:	 Post-course Teacher Survey #2 
To fill out and submit this form, please go to the Post-Course Survey link on the course website. I have copied the survey here merely for 
reference; you will submit your responses via the Course Website.  A copy of your completed form should be e-mailed to you after submit-
ted.  A couple brief, succinct sentences should suffice

About how many hours did you spend complet-
ing all  the assignments?

Did you do the bulk of the work at home or at 
school?

Did you have other sources of information to 
help you with this course (family members, col-
leagues, etc.)? If so, how did they help?

Do you plan to continue with your use of com-
puters? If so, how?

Describe your comfort level as you progressed 
through the course. 
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Project 23:	 Course Evaluation
To fill out and submit this form, please go to the Pre-Course Survey link on the course website. I have copied the survey here merely for 
reference; you will submit your responses via the Course Website.  

Did this course meet your expectations? Please briefly 
explain.

How do you feel about the structure of the course?  
Was it organized in an orderly way, making it easy to 
follow?  How would you improve the structure?

Have you any comments to offer about the assign-
ments?

How did the workload of this course compare to that 
of other courses with equivalent units?

How did you hear about the course?

Would you recommend this course to others?
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About Your Instructor ...
I was born in 1953 at the Presidio in San Francisco, California. 
The second child of Maj. John and Bette Jane Young, I was en-
thusiastically welcomed by my only sibling - a brother, six years 
my senior. After my dad retired from the Army he still had a touch 
of the wanderlust so we spent the next few years exploring Wyo-
ming and Colorado. In 1963 we settled in Durango where my 
brother and I spent our days climbing trees, skipping stones 
across the Animas River, and exploring the La Plata mountains, 
which were our backyard. 

In the late 1960s my parents moved back to the Bay area of 
California where I finished high school then went off to college, 
enrolling at California State University in Fresno. I majored in 
Mass Communications - a combination of English, Theater Arts 
and the technical aspects of radio, television and film produc-
tion. I had those typical, youthful aspirations of becoming a ‘rich 
and famous’ script writer and filmmaker. Upon graduation I part-
nered with a local film production company and spent  the next 
several years writing, producing and filming documentaries and 
television commercials. A combination of the reality of parent-
hood and a souring economy in the early ‘80’s guided my deci-
sion to return to school to obtain my teaching credential. The 
birth of my daughter in 1983 cemented my decision to opt for the 
stability of teaching over the uncertain world of the arts. I began 
as a classroom teacher at the same time computers were first 
being introduced to the public, in general, and schools. I have 
always had an affinity for machines and gadgets so I soon tran-
sitioned from ‘traditional’ teaching to working with technology in 
education; the best decision ever!

Within a year I was the Technology Teacher/Coordinator for a 
small high school; teaching programming in a lab and setting up 
local area networks. As technology evolved and became more 
affordable, the District purchased classroom computers and I, 
seeing the need, began writing record-keeping and database 
programs for teachers. 

By the early ‘90’s I was assisting with technology District-wide 
and speaking at regional and state conferences. It was at this 
time I began teaching summer and weekend seminars at Fresno 
Pacific University (then Fresno Pacific College) on integrating 
technology in to the classroom. Through membership in CTAP 
(California Technology Assistance Project) I also provided pro-
fessional development, planning, and implementation assis-
tance to help schools utilize technology to support teaching and 
learning. 

I recently retired after more than 30 years of service to Madera 
Unified School District. With my ‘extra’ time, I will be develop-
ing new courses for Fresno Pacific. My wife, Becky, and I enjoy 
interacting with teachers from all over the country - we recently 
began traveling across the US on Amtrak and have already 
logged over 10,000 miles riding the rails, making whistle stops 
at many of your hometowns!

Using a Steadicam during 
the filming of a commercial 
for a regional TV station in 
the days before gray hair! 
 

In San Francisco receiv-
ing California’s prestigious 
Golden Bell Award for an 
exemplary program in tech-
nology, with Madera Unified 
school board trustees.

My beautiful bride Becky, 
on our wedding day! After 
all these years she's still 
the love of my life (and the 
world's greatest cook!).

Taking a break at my desk 
at Madera Unified, while 
administering an early (circa 
1990) school-wide network.

Scuba diving (a passion of 
mine) with my daughter off 
the coast of Maui, in the 
beautiful state of Hawai’i.

Visiting the St. Louis Arch 
with my wife - a day trip from 
Indianapolis after our annual 
trip to the Indy 500.

Me with Becky’s family, in-
cluding her three children 
and all eight (so far!) of our 
grandkids, at Becky's par-
ents' 60th wedding anniver-
sary celebration.

Fishing the Animas River 
in Durango, CO, where my 
brother and I used to roam. 
Pretty nice catch! We only 
keep what we eat, and this 
one was delicious! 
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DIRECTIONS FOR SUBMITTING A REQUEST FOR ONLINE GRADINGDIRECTIONS FOR SUBMITTING A REQUEST FOR ONLINE GRADING

FPU requires I submit your grade online. For me to do that you must request online grading 
via your FPU account. When you’ve submitted your completed coursework (no sooner):

•	  Login to your account on the CPD website at https://ce.fresno.edu/my-account 

•	 Click on ‘Request Final Grade’

•	 Select this course from the list of ungraded courses in 
which you are currently enrolled

•	 Click the box confirming accuracy of the information

•	 Click Submit

•	 FPU will email me that you have completed the course and 
are ready to be graded 

Please submit your request for online grading the same day 
you submit your completed coursework (no sooner). I cannot submit your grade until online 
grading has been requested. 

If I receive your final coursework but you’ve yet to request online grading, expect a delay 
while I attempt to contact you in reminder. If you encounter technical difficulties with the on-
line grading system please contact FPU directly; I am unable to troubleshoot their system. 

Once I have submitted your grade to FPU I will notify you via email that this has been ac-
complished. Processing grades submitted electronically is not automatic; FPU strives to post 
grades the same day, but it may take up to 2 business days to certify and post your grade 
(FPU will email you once your grade has been posted). 

Prior to ordering a transcript, particularly a ‘RUSH’ transcript, verify your grade has officially 
been posted. Login to your FPU account and click Final Grade Report. If your grade in this 
course appears, print off your Final Grade Report (FPU no longer mails Grade Reports - you 
must print them out yourself) and proceed with ordering transcripts. 

If this course does not appear, although I notified you I submitted your grade, please contact 
FPU (1-800-372-5505) directly with your inquiry. It may be they are ‘holding’ your grade for 
whatever reason, typically if you are overenrolled.

I hope you found the course beneficial. I’ll keep an eye out for your packet, and look forward 
to reviewing your work! Again and as always, thanks!


